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kenmerken van uw nieuwe MP3-speler
Mooi. Intelligent. Betrouwbaar. En vooral leuk! Dat is uw nieuwe MP3-speler, 
en nog veel meer. De ultramoderne technologie zorgt voor een krachtig 
geluid en heldere beelden. U zult heel veel plezier beleven aan uw nieuwe 
MP3-speler, of u nu aan het sporten bent, uw favoriete nummers downloadt, 
video’s bekijkt of gewoon naar de radio luistert.
Nadat u hem eenmaal het gebruikt, vraagt u zich af hoe u ooit zonder hebt 
gekund.
MEER MULTI IN MULTIMEDIA
We noemen het een MP3-speler, maar het 
is veel meer dan dat. U kunt afbeeldingen, 
tekst en video’s bekijken en naar FM-radio 
luisteren.
De ingebouwde draadloze Bluetooth-
technologie verandert uw MP3-speler in uw 
eigen persoonlijke netwerk.

AANRAAKBEDIENING
Door licht op het aanraakscherm te tikken 
kunt u door de menu’s bladeren.

LCD-KLEURENSCHERM
Op het brede LCD-scherm worden heldere 
kleuren en beelden weergegeven.

WAAR VORM EN FUNCTIONALITEIT 
HAND IN HAND GAAN
Jazeker, hij is gestroomlijnd en mooi. Maar 
hij ligt ook lekker in de hand en is eenvoudig 
te bedienen.

EENVOUDIG ZOEKEN
U kunt zoeken naar bestanden met de 
eenvoudig te gebruiken Bestandsbrowser. 
Bovendien kunt u door menu’s navigeren 
terwijl u naar muziek luistert.

LANGERE AFSPEELDUUR EN KORTERE 
DOWNLOADTIJD
Met een volledig geladen batterij kan 
maximaal 35 uur muziek en 5 uur video 
worden afgespeeld.
Het downloaden gaat sneller. Dankzij de 
compatibiliteit met USB 2.0 is de speler veel 
sneller dan modellen met USB 1.1.

WONDER VAN GELUIDSKWALITEIT
Uw nieuwe MP3-speler is uitgerust met 
DNSe™ (Digital Natural Sound-engine), 
de unieke geluidstechnologie van Samsung 
voor een rijker, dieper geluid en een 
ongelofelijke luisterbeleving.



veiligheidsinformatie
Betekenis van de pictogrammen en aanduidingen in deze gebruiksaanwijzing:

WAARSCHUWING

Risico van lichamelijk letsel met mogelijk fatale 
gevolgen.

LET OP
Risico van lichamelijk letsel of materiële schade.

LET OP

U kunt het risico op brand, ontploffi ng, elektrische schokken of 
lichamelijk letsel tijdens het gebruik van uw MP3-speler verminderen 
door de genoemde belangrijke voorzorgsmaatregelen in acht te nemen.

OPMERKING

Tips of verwijzingen naar informatie die u kunnen helpen 
bij het bedienen van de speler.

NIET proberen.

NIET demonteren.

NIET aanraken.

Volg de aanwijzingen nauwgezet op.

Haal de stekker uit het stopcontact.

Bel het servicecentrum voor assistentie.

Deze waarschuwingstekens dienen om persoonlijk letsel, van uzelf en van 
anderen, te voorkomen.
Voer de aanwijzingen nauwgezet op.
Bewaar de gebruiksaanwijzing nadat u dit gedeelte hebt doorgelezen op een 
veilige plaats, zodat u deze informatie later nog eens kunt naslaan. 



veiligheidsinformatie
In deze gebruiksaanwijzing wordt het juiste gebruik van uw nieuwe 
MP3-speler beschreven. Lees de gebruiksaanwijzing zorgvuldig door 
om te voorkomen dat u de speler beschadigt of uzelf verwondt.
Let met name op de volgende serieuze waarschuwingen:

BESCHERM UZELF
Demonteer, repareer of wijzig het product niet zelf.

Zorg dat het product niet nat wordt. Het product is niet waterbestendig. 
Als het product nat wordt, schakel het dan niet in. Anders zou u een 
elektrische schok kunnen krijgen. Neem in dat geval contact op met het 
dichtstbijzijnde Samsung Service Center.

Gebruik de oordopjes niet als u op een fi ets zit of een auto of motor 
bestuurt.
Dit kan een ernstig ongeluk veroorzaken. Het is bovendien in enkele landen bij wet 
verboden.
Gebruik van de oortelefoon tijdens het lopen en joggen op de openbare weg, met 
name tijdens het oversteken, kan leiden tot ernstige ongelukken.

Let er tijdens het sporten of wandelen omwille van de veiligheid op dat 
de kabel van de oortelefoon niet achter uw arm of een object in uw 
omgeving kan blijven haken.

Plaats het product niet in een vochtige, stoffi ge of vuile omgeving. Anders 
zou brand kunnen ontstaan of loopt u het risico op een elektrische schok.

LET OP

WAARSCHUWING

LET OP



BESCHERM UZELF
Het gebruik van oortelefoon of hoofdtelefoon gedurende langere tijd kan 
leiden tot ernstige gehoorbeschadiging.
Blootstelling voor langere tijd aan een geluidsniveau van meer dan 85 dB kan uw 
gehoor nadelig beïnvloeden. Hoe hoger het geluidsniveau, des te ernstiger de 
mogelijke gehoorschade. (Een normaal gesprek vindt plaats op een niveau van 50 
tot 60 dB. Het geluidsniveau op de weg is ongeveer 80 dB.) U wordt uitdrukkelijk 
aanbevolen het volumeniveau op medium te zetten. (Medium is doorgaans minder 
dan 2/3 van het maximum.)
Als u een piep in uw oren ervaart, moet u het volume verlagen of het 
gebruik van oortelefoon of hoofdtelefoon staken.

UW MP3-SPELER BESCHERMEN
Bewaar of gebruik de speler niet bij temperaturen boven 35°C 
(bijvoorbeeld een sauna of in een geparkeerde auto).
Zorg dat u de speler nergens tegen stoot en laat de speler niet vallen.
Plaats geen zware voorwerpen op de speler.
Voorkom dat externe deeltjes of stof in het product komen.
Plaats het product niet in de buurt van magnetische objecten.
Zorg dat u een reservekopie van belangrijke gegevens maakt. Samsung is 
niet aansprakelijk voor verlies van gegevens.
Gebruik uitsluitend door Samsung geleverde of goedgekeurde 
accessoires.
Spuit geen water op het product. Maak het product niet schoon met 
chemicaliën als benzeen of thinner. Hierdoor kan er brand ontstaan, kunt 
u een elektrische schok krijgen en kan het oppervlak beschadigd raken.
Het niet opvolgen van deze instructies kan tot lichamelijk letsel leiden of 
schade aan de speler veroorzaken.

Als u deze gebruiksaanwijzing wilt afdrukken, adviseren we u dat u deze in 
kleur afdrukt en de optie “Aan pagina aanpassen” in de afdrukopties selecteert 
voor een betere weergave.

LET OP

OPMERKING

WAARSCHUWING

LET OP
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basisinformatie
INHOUD VAN DE VERPAKKING
Bij uw nieuwe MP3-speler worden de volgende accessoires geleverd. Als een van 
deze items ontbreekt, moet u contact opnemen met de klantenservice van Samsung.

Speler Oortelefoon USB-kabel Installatie-cd Easy Holder

Het ontwerp van de accessoires kan ter verbetering van het product zonder 
voorafgaande kennisgeving worden gewijzigd.

De Easy Holder gebruiken
Plaats de speller op de Easy holder op een plat oppervlak. Op deze 
manier kunt u video’s bekijken zonder de speler vast te houden.

Het is geen vaste houder, dus schud er niet mee.
OPMERKING
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UW MP3-SPELER

Aanraakscherm

Aan/uit-lampje
Het aan/uit-lampje is rood als 
de batterij wordt opgeladen. Als 
de batterij volledig is opgeladen, 
wordt het lampje groen.

 Toets Volume omhoog
Indrukken om het volume te verhogen

 Toets Volume omlaag
Indrukken om het volume te verlagen

Resetopening
Als er een storing in 
de speler optreedt, 
drukt u met een 
puntig voorwerp in de 
resetopening om het 
systeem opnieuw te 
initialiseren.

Haak van de Easy Holder
De lus van de Easy Holder bevestigen
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UW MP3-SPELER (vervolg)

Schakelaar Hold (Vergrendelen) 
Indrukken in de richting van de pijl om de 
functietoetsen te vergrendelen.

USB-aansluiting
Toets Aan/Uit en Afspelen/Pauze 
Indrukken voor afspelen/pauze.
Iets langer indrukken om het apparaat in of 
uit te schakelen.

Oortelefoonaansluiting

Oortelefoon
Op het linkerdopje 
ziet u een 
“L” en op het 
rechterdopje een 
“R”. Fungeert 
tevens als 
antenne voor de 
FM-radio in de 
MP3-speler.
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SCHERMEN
Video

1
Bluetooth/Vergrendeling/
Alarmindicator 7 Afspelen/pauze, zoeken

2 Batterijstatus 8 Indicator videomodus

3 Huidige tijd 9 Statusbalk afspelen

4 Huidige/totale afspeeltijd 10 Pictogram Vorige

5 Bestandsnaam 11 Pictogram Menu

6
Pictogram Afspelen/pauze, 
Zoeken
De schermafbeeldingen dienen slechts ter illustratie. Het scherm kan er in 
werkelijkheid anders uitzien.
Informatie en pictogrammen verdwijnen na enige tijd bij het afspelen van 
video’s. Tik op het scherm als u deze informatie en pictogrammen weer wilt 
weergeven.

Video Track 1

11

3

1

28

7

4

6

9

10

5

OPMERKING
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SCHERMEN (vervolg)
Muziek

1
Bluetooth/Vergrendeling/
Alarmindicator

2 Huidige tijd

3 Batterijstatus

4 Indicator huidig nummer/totaal 
aantal nummers

5 Muziekafspeelscherm

6 Statusbalk afspelen

7 Huidige/totale afspeeltijd

8
Pictogram Afspelen/pauze, 
Zoeken

9 Pictogram DNSe

10 Afspelen/pauze, zoeken

11 Indicator muziekmodus

12 Indicator hoofdmenu

13 Titel

14 Indicator DNSe-modus

15 Indicator afspeelmodus

16 Pictogram Vorige

17 Pictogram Menu

Audio Track 1

Songs 1/52
3

4

1

2

10

12

11

13

5

14

15
6

7

8

916

17
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SCHERMEN (vervolg)
Afbeelding

1
Bluetooth/Vergrendeling/
Alarmindicator

2 Huidige tijd

3 Batterijstatus

4 Indicator huidig bestand/totaal 
aantal bestanden

5 Pictogram Volgende afbeelding

6 Pictogram Zoom

7 Afspeelstatus muziek

8 Indicator Afbeeldingsmodus

9 Bestandsnaam

10 Pictogram Vorige afbeelding

11 Pictogram Vorige

12 Pictogram Menu

Informatie en pictogrammen verdwijnen na enige tijd bij het weergeven van 
afbeeldingen. Tik op het scherm als u deze informatie en pictogrammen 
weer wilt weergeven.
Het pictogram Vorige/Volgende afbeelding [ ,  ] wordt weergegeven als 
u één keer op het scherm tikt. Als u nogmaals op het scherm tikt worden 
zowel afbeeldingsinformatie als pictogrammen weergegeven.

Picture image 1 8/17
3

4

1

2

7

9

8

510

611

12

OPMERKING

[Afbeeldingsweergavescherm]
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SCHERMEN (vervolg)
FM-radio

1
Bluetooth/Vergrendeling/
Alarmindicator

2 Huidige tijd

3 Batterijstatus

4 Handmatig/voorkeuze

5
Pictogram
Voorgeprogrammeerd nummer

6 Indicator radiomodus

7 Huidige frequentie (MHz)

8 Frequentielocatie

9 Pictogram Vorige

10 Pictogram Menu

FM Radio
3

1

2

5

8

9

10

4
7

6
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WERKEN MET HET AANRAAKSCHERM
Tik met uw vingertop op het aanraakscherm.

Gebruik geen kracht bij het aanraken van het scherm. Dit kan het scherm 
beschadigen.
Gebruik geen andere voorwerpen dan uw vingers om op het scherm te tikken. 
Anders zou het aanraakscherm kunnen beschadigen.
Tik niet op het aanraakscherm met vuile vingers.
Tik niet op het aanraakscherm met handschoenen aan.
Het aanraakscherm werkt mogelijk niet goed als u bijvoorbeeld uw vingernagel of 
een balpen gebruikt.

OPMERKING
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WERKEN MET HET AANRAAKSCHERM (vervolg)
U kunt in vier richtingen op het scherm tikken; omhoog, omlaag, links en rechts, 
afhankelijk van de functie
Voorbeeld: afspeelstatusbalk

Instructie 1
Plaats uw vinger op de afspeelstatusbalk 
op het scherm, beweeg uw vinger naar een 
gewenst punt en haal uw vinger van het 
scherm.

De speler gaat verder met afspelen vanaf het punt 
waar u uw vinger van het scherm hebt gehaald.

Instructie 2
Tik op een gewenst punt in de afspeelstatusbalk.
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WERKEN MET HET AANRAAKSCHERM (vervolg)
Voorbeeld: ingezoomde afbeelding

Instructie 3
Plaats uw vinger op het scherm, beweeg uw vinger in de gewenste 
richting en haal uw vinger van het scherm, zoals weergegeven in 
onderstaande afbeelding.

Beweeg uw vinger in de zoommodus in de gewenste richting. 
De afbeelding wordt verplaatst en weergegeven in de nieuwe positie.
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WERKEN MET HET AANRAAKSCHERM (vervolg)
Voorbeeld: het volgende/vorige videobestand afspelen

Instructie 4
Beweeg uw vinger naar links of rechts.

Links : u gaat naar het volgende bestand (afhankelijk van de instelling voor 
horizontale slag. (Zie pagina 44.)

Rechts : u gaat naar het vorige bestand (afhankelijk van de instelling voor 
horizontale slag. (Zie pagina 44.)

Video Track 1
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DE BATTERIJ OPLADEN
Laad de speler op voordat u deze voor het eerst gebruikt en wanneer u deze 
lange tijd niet hebt gebruikt.
Het volledig opladen van de batterij van de MP3-speler duurt ongeveer 
vier en een half uur. De oplaadtijd kan echter variëren, afhankelijk van uw 
computeromgeving.

1. Sluit het andere (grotere) uiteinde van de USB-kabel aan op de USB-
aansluiting aan de onderkant van de speler.

2. Sluit de USB-kabel aan op de USB-poort ( ) van de computer.
Het aan/uit-lampje is rood als de batterij wordt opgeladen. Als de batterij volledig is 
opgeladen, wordt het lampje groen.

1

2

Aan/uit-lampje
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ONDERHOUD VAN DE BATTERIJ
De batterij gaat langer mee als u de volgende eenvoudige aanwijzingen voor 
het gebruik en de opslag ervan opvolgt.
• Opladen en bewaren bij een temperatuur tussen 5°C en 35°C.
• De batterij niet te lang opladen (niet langer 12 uur). 

Overmatig opladen of ontladen kan de levensduur van de batterij verkorten. 
• Aangezien een batterij een verbruiksartikel is, neemt de levensduur van de 

batterij na verloop van tijd geleidelijk af.
Als u de speler oplaadt door deze aan te sluiten op een draagbare computer, 
controleer dan eerst of de batterij van de draagbare computer zelf volledig is 
opgeladen of de draagbare computer is aangesloten op het lichtnet.
De batterij wordt niet opgeladen in de stand-bymodus van de pc of wanneer de 
hardware veilig wordt verwijderd.

DE SPELER IN- EN UITSCHAKELEN
De speler inschakelen
Houdt de toets enige tijd ingedrukt.

De speler wordt ingeschakeld.

De speler uitschakelen
Houdt de toets enige tijd ingedrukt.

De speler wordt uitgeschakeld.

Het toestel wordt automatisch uitgeschakeld als gedurende 
een bepaalde tijd geen toetsen worden ingedrukt in de 
stopstand. De fabrieksinstelling voor <Auto Power Off> 
(Autom. uitschakelen) is 1 minuut, maar u kunt deze tijd zelf 
wijzigen. Zie pagina 33 voor meer informatie.
Zie pagina 25 voor het gebruik van <Cosmos> (Cosmos) in het hoofdmenu.

OPMERKING

OPMERKING
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EEN VIDEOBESTAND AFSPELEN
Kopieer videobestanden naar uw nieuwe MP3-speler met Samsung Media 
Studio. Meer informatie over Media Studio vindt u op pagina 37.
1. Tik op het pictogram  in het hoofdmenu.

De lijst met video’s wordt weergegeven.

2. Selecteer een af te spelen videobestand en tik 
erop.

Het geselecteerde videobestand wordt horizontaal 
afgespeeld.

Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

HET VOLUME REGELEN
U kunt het volume aanpassen als een bestand is gestopt of tijdens het afspelen.

Instructie 1
Druk op de toets  , .

De volumebalk wordt weergegeven. 
Het volumebereik is ingesteld van 0 tot 30.
Druk op de toets  om het volume te 
verhogen of op de toets om het te 
verlagen.

Instructie 2
Beweeg uw vinger omhoog of omlaag rechts in het midden van het scherm.

De volumebalk wordt weergegeven.
Als u uw vinger omhoog beweegt, wordt het volume verhoogd en als u uw 
vinger omlaag beweegt, wordt het volume verlaagd.

OPMERKING

Video Track 1
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DE TOETSEN VERGRENDELEN
Met de vergrendelfunctie kunt u alle andere toetsen en pictogrammen op de 
MP3-speler vergrendelen, zodat uw muziek niet wordt onderbroken wanneer 
een van de toetsen, bijvoorbeeld tijdens het sporten, per ongeluk wordt 
ingedrukt.
1. Duw de schakelaar in de richting van 

de pijl.
2. Schuif de schakelaar in de 

tegenovergestelde richting van de pijl om de 
vergrendelfunctie uit te schakelen.

BESTANDEN ZOEKEN MET “File Browser” 
(Bestandsbrowser)
U kunt eenvoudig bestanden zoeken met de functie <File Browser>
(Bestandsbrowser).
1. Tik op het pictogram  in het hoofdmenu.

De map <File Browser> (Bestandsbrowser) wordt weergegeven, 
met daarin “Video, Music, Playlists, Pictures, Datacasts en 
Texts”.

2. Selecteer de gewenste map.
3. Tik op de geselecteerde map om de bestandslijst weer te 

geven.
Druk op het pictogram [ ] om naar het vorige scherm te gaan.

4. Selecteer het gewenste bestand.
5. Tik op het geselecteerde bestand.

Het bestand wordt afgespeeld.

Video Track 1

Video

Music

Playlists

Pictures

Datacasts

Texts

File Browser 1/6
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INSTELLINGEN EN VOORKEUREN WIJZIGEN
De instellingen en voorkeuren van de MP3-speler zijn in de fabriek ingesteld, 
maar u kunt deze voorgeprogrammeerde waarden zelf aan uw persoonlijke 
voorkeuren aanpassen.

Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

Instellingen voor menustijl
U kunt het uiterlijk van het menu wijzigen en de achtergrondafbeelding 
van het hoofdmenu verwijderen.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt weergegeven.

2. Selecteer <Menu Style> (Menustijl) en tik erop.
Het menu <Menu Style> (Menustijl) wordt weergegeven.

3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.

Instellingsopties voor menustijl 
Menu Design (Menuontwerp) : U kunt de stijl van het hoofdmenu wijzigen. 
Maak een keuze uit <Cosmos> (Cosmos), <Matrix> (Matrix) en <My Skin> (Mijn 
Skin). Zie pagina’s 25-26
Font (Lettertype) : U kunt het lettertype van de menutaal wijzigen. Kies één 
van de drie lettertypes. Voor sommige talen wordt <Font> (Lettertype) niet 
weergegeven in het menu.
Reset My Skin (Mijn Skin opnieuw instellen) : Stelt de achtergrondafbeelding 
van het aanraakscherm in op de standaardafbeelding.

Als u in het scherm <Settings> (Instellingen) gedurende 1 minuut geen 
toetsen indrukt, gaan de instellingen die u nog niet hebt opgeslagen 
verloren en keert de speler terug naar de voorgaande functie.

OPMERKING

OPMERKING

Settings

Menu Style
Sound

Display

Language

Time

System
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Het menu Cosmos gebruiken
Instructie 1
Plaats uw vinger op het aanraakscherm en beweeg uw vinger omhoog of 
omlaag. Tik op het pictogram van het gewenste hoofdmenu.

Instructie 2
Plaats uw vinger op een lege ruimte van het aanraakscherm en 
beschrijf met uw vinger voorzichtig een cirkel. 
Tik op het pictogram van het gewenste hoofdmenu.

Het menu <Cosmos> (Cosmos)
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Het menu Matrix gebruiken
Tik op het pictogram van het gewenste hoofdmenu.

Het menu Mijn Skin gebruiken
Plaats uw vinger op het aanraakscherm en blader naar links of rechts 
door uw vingertop in de gewenste richting te bewegen en van het 
scherm te halen. Tik op het pictogram van het gewenste hoofdmenu.

Het menu <Matrix>

Het menu <My Skin> (Mijn huid)
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Geluidsinstellingen
U kunt de hoofd-EQ, de pieptoon en de volumegrens instellen.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt 
weergegeven.

2. Selecteer <Sound> (Geluid) en tik erop.
Het menu <Sound> (Geluid) wordt weergegeven.

3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.

Opties voor geluidsinstellingen 
Master EQ (Hoofd-EQ) : U kunt de geluidsinstellingen optimaliseren. Tik op het 
pictogram [ ,  ] om de frequentie die u wilt aanpassen, te selecteren. 
De frequenties die kunnen worden aangepast, zijn <60Hz>, <150Hz>, <400Hz>, 
<1.1kHz>, <3.5kHz>, <8kHz> en <14kHz>. Tik op het pictogram [ , ] om het 
niveau van de geselecteerde frequentie aan te passen en tik op <OK>.
Beep Sound (Piepgeluid) : Het geluidssignaal voor de bediening van het 
aanraakscherm inschakelen of uitschakelen. U kunt kiezen tussen <Off> (Uit) 
en <On> (Aan).
Volume Limit (Volumegrens): U kunt gehoorbeschadiging bij gebruik van de 
koptelefoon voorkomen door een volumegrens in te stellen. Als de volumegrens 
is ingeschakeld, is het maximumvolume 15. 
Als de volumegrens is uitgeschakeld, is het maximumvolume 30.
Als u <Off> (Uit) selecteert, wordt het volume teruggezet naar 15 om schade 
aan uw gehoor te voorkomen wanneer u de speler weer inschakelt.

U kunt de <Master EQ> (Hoofd-EQ) niet instellen als de speler is 
verbonden met de Bluetooth-stereokoptelefoon.

Settings

Menu Style

Sound

Display

Language

Time

System

OPMERKING
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Weergave-instellingen
De uitschakeltijd en helderheid van uw scherm wijzigen.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt 
weergegeven.

2. Selecteer <Display> (Weergave) en tik erop.
Het menu <Display> (Weergave) wordt weergegeven.

3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.

Opties voor weergave-instellingen
Display Off (Display Uit): Het aanraakscherm wordt automatisch uitgeschakeld 
als er gedurende de onderstaande tijd geen toetsen of pictogrammen worden 
aangeraakt. U kunt kiezen uit <15sec>, <30sec>, <1min>, <3min>, <5min> en 
<Always On> (Altijd aan). U kunt het scherm weer inschakelen door op een 
willekeurige toets te drukken. 
Brightness (Helderheid) : U kunt de helderheid van het scherm instellen. Kies 
een niveau van <0-10>, met 10 als meest helder.

Settings
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Taalinstellingen
De menu’s van de MP3-speler kunnen in diverse talen worden 
weergegeven. U kunt uw voorkeurstaal eenvoudig instellen.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt 
weergegeven.

2. Selecteer <Language> (Taal) en tik erop.
Het menu <Language> (Taal) wordt weergegeven.

3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.

Settings

Menu Style

Sound

Display
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Time

System
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Opties voor taalinstellingen

Menu : De menutaal instellen. Tik op het pictogram [  ,  ] om naar de vorige/
volgende pagina te gaan.
U kunt kiezen uit <English>, <한국어>, <Français>, <Deutsch>, <Italiano>, 
<日本語>, < >, < >, <Español>, < >, <Magyar>, 
<Nederlands>, <Polski>, <Português>, <Svenska>, < >, < eština>,
< >, <Türkçe>, <Norsk>, <Dansk>, <Suomi>, <Español 
(Sudamérica)>, <Português (Brasil)>, <Indonesia>, <Ti ng Vi t>, <Bulgarian>, 
<Român >, < >, <Slovenš ina> of <Slovenský>.
Contents (Inhoud) : De taal instellen waarin de nummergegevens en tekst 
worden weergegeven. Tik op het pictogram [  ,  ] om naar de vorige/
volgende pagina te gaan. U kunt kiezen uit <English>, <Korean>, <French>, 
<German>, <Italian>, <Japanese>, <Simplifi ed Chinese>, <Tranditional 
Chinese>, <Spanish>, <Russian>, <Hungarian>, <Dutch>, <Polish>, 
<Portuguese>, <Swedish>, <Thai>, <Finnish>, <Danish>, <Norwegian>, 
<Farsi>, <Afrikaans>, <Basque>, <Catalan>, <Czech>, <Estonian>, <Greek>, 
<Hrvatski>, <Icelandic>, <Rumanian>, <Slovak>, <Slovene>, <Turkish> of 
<Vietnamese>.

De ondersteunde talen kunnen worden gewijzigd of toegevoegd.
OPMERKING
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Tijdinstellingen
Door de tijd in te stellen kunt u de ingestelde datum/tijd, het datumtype 
en zelfs de tijdzone gebruiken.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt 
weergegeven.

2. Selecteer <Time> (Tijd) en tik erop.
Het menu <Time> (Tijd) wordt weergegeven.

3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.

Opties voor Tijdinstellingen
Date/Time Set (Datum/tijd instellen) : De huidige datum en tijd instellen. Tik 
op het pictogram [ , ] om <Year>(Jaar), <Month>(Maand), <Day>(Dag), 
<Hour>(Uur), <Min> en <AM/PM> (AM/PM) in te stellen.
Date Type (Datumtype) : U kunt het type tijdweergave voor de wereldklok 
instellen. U kunt kiezen uit <YY-MM-DD>(JJ-MM-DD), <MM-DD-YY>(MM-DD-
JJ) en <DD-MM-YY>(DD-MM-JJ).
Time Zone (Tijdzone) : U kunt de huidige tijd wijzigen door een internationale 
tijdzone te selecteren. U moet de tijdzone instellen voordat de wereldtijd kan 
worden weergegeven. Zie pagina 86
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Systeeminstellingen
Kies de instellingen voor de sluimerfunctie en automatisch uitschakelen 
die bij u passen.
1. Tik op het pictogram  in het hoofdmenu.

Het menu <Settings> (Instellingen) wordt 
weergegeven.

2. Selecteer <System> (Systeem) en tik erop.
Het menu <System> (Systeem) wordt weergegeven.

3. Tik op een gewenst menu.
4. Stel uw voorkeuren in en tik op <OK>.
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Opties voor systeeminstellingen

Sleep (Stand-by) : Het apparaat wordt na de opgegeven tijd automatisch 
uitgeschakeld. U kunt kiezen uit <Off> (Uit), <15 min >, <30 min>, <60 min>, 
<90 min> en <120 min>.
Start Mode (Startmodus) : U kunt instellen dat het startscherm wordt 
weergegeven als u de speler inschakelt. U kunt kiezen uit <Home>(Start) en 
<Last State>(Vorige status). Kies <Home>(Start) om het systeem op te starten 
in het hoofdmenu of <Last State>(Vorige status) om op te starten in het laatst 
gebruikte menuscherm.
Auto Power Off (Autom. Uitschakelen) : De speler wordt automatisch 
uitgeschakeld als het afspelen is onderbroken en er gedurende de opgegeven 
tijd geen toetsen worden ingedrukt. U kunt kiezen uit <15sec>, <30sec>, 
<1min>, <3min>, <5min> of <Always On>(Altijd aan).
Default Set (Standaard instellen) : De standaardwaarden voor alle instellingen 
worden hersteld. U kunt kiezen uit <YES> (Ja) en <NO> (Nee). Met <YES> (Ja) 
zet u alle instellingen terug naar de beginwaarden. Met <NO> (Nee) annuleert u 
het herstellen van de standaardinstellingen.
Format (Formatteren) : Het interne geheugen formatteren. U kunt kiezen uit 
<YES> (Ja) en <NO> (Nee). Als u <YES> (Ja) kiest, wordt het interne geheugen 
geformatteerd en worden alle bestanden op de speler gewist. Als u <NO> (Nee) 
selecteert, wordt het interne geheugen niet geformatteerd. Controleer voordat u 
gaat formatteren.
About (Info) : De fi rmwareversie en geheugencapaciteit controleren. 

Firmware - Hier wordt de huidige versie van de fi rmware weergegeven.
Memory (Geheugen) - Geeft de resterende geheugencapaciteit aan. 

<Used>(Gebruikt) geeft het gebruikte geheugen 
aan, <Remaining>(Resterend) geeft het resterende 
geheugen aan en <Total>(Totaal) staat voor de 
totale geheugencapaciteit.

Het ingebouwde geheugen
1GB=1.000.000.000 bytes: de werkelijke, geformatteerde capaciteit is 
mogelijk minder omdat een gedeelte van het geheugen wordt gebruikt door 
de interne fi rmware.

OPMERKING
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DE MP3-SPELER RESETTEN
Als uw MP3-speler niet start, geen muziek wil afspelen of niet wordt herkend 
door uw computer wanneer u deze aansluit, is het misschien nodig het systeem 
te resetten.

Druk met een puntig voorwerp, zoals een 
veiligheidsspeld, aan de onderzijde van het 
product de Resetopening in.

Het systeem wordt geïnitialiseerd.
Met de Reset-functie worden geen 
tijdgegevens en gegevens in het ingebouwde 
geheugen verwijderd.
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samsung media studio
Samsung Media Studio is een gebruiksvriendelijke softwaretoepassing 
voor het ordenen van muziek-, foto-, video- en andere bestanden op 
uw computer. Nadat uw bestanden zijn geordend in Media Studio, kunt 
u deze in een handomdraai overzetten naar uw MP3-speler, zonder dat 
u de hele vaste schijf hoeft te doorzoeken voor het juiste bestand.

SYSTEEMVEREISTEN
Uw computersysteem moet voldoen aan de volgende minimum specifi caties 
voor installatie en gebruik van Media Studio:
• Pentium 500MHz of hoger
• USB 2.0-poort
• Windows XP Service Pack 2 of hoger
• DirectX 9.0 of hoger
• 100 MB vrije schijfruimte
• Cd-romstation (2x of hoger)
• Windows Media Player 10.0 of hoger
• Resolutie 1024 X 768 of hoger
• Internet Explorer 6.0 of hoger
• 512 MB RAM of hoger
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SAMSUNG MEDIA STUDIO INSTALLEREN
Voer het installatieprogramma van <Media Studio> uit via de beheerdersaccount 
op uw computer. Anders wordt <Media Studio> niet geïnstalleerd. Meer informatie 
over het gebruik van de beheerdersaccount vindt u in de gebruiksaanwijzing van uw 
computer.

1. Plaats de installatie-cd die bij de speler is 
geleverd in het cd-romstation.

2. Klik op <Install now> (Nu installeren).

3. Klik op <NEXT> (Volgende).
De installatie van <Media Studio> wordt gestart. 
Wanneer de installatie is voltooid,  verschijnt een 
pictogram op uw bureaublad.

Next >

LET OP
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
SAMSUNG MEDIA STUDIO
Met <Media Studio> kunt u bestanden en mappen selecteren en ordenen voordat 
u deze overbrengt naar de speler. Het opzoeken van bestanden op uw MP3-speler 
wordt hierdoor versneld en vereenvoudigd. <Media Studio> biedt de handigste 
manier om uw bestanden van uw computer over te zetten naar uw MP3-speler.

1

2

1. Sluit het andere (grotere) uiteinde van de USB-kabel aan op de USB-
aansluiting aan de onderkant van de speler.

2. Sluit de USB-kabel aan op de USB-poort ( ) van de computer.
Op het aanraakscherm van de speler wordt <USB connected>(USB aangesloten) 
weergegeven.
<Media Studio> wordt automatisch gestart op het moment dat de speler wordt 
aangesloten op de computer.
Als het programma niet automatisch wordt gestart, dubbelklikt u op het pictogram 
<Media Studio> op het bureaublad.

De technologie voor het herkennen van muziek en verwante gegevens wordt 
geleverd door Gracenote en Gracenote CDDB® Music Recognition ServiceSM.
CDDB is een gedeponeerd handelsmerk van Gracenote. Het logotype en logo 
van Gracenote, Gracenote CDDB en het logo “Powered by Gracenote CDDB” zijn 
gedeponeerde handelsmerken van Gracenote. Music Recognition Service en MRS 
zijn servicemerken van Gracenote.

OPMERKING
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
SAMSUNG MEDIA STUDIO (vervolg)
3. Klik op het pictogram voor het type bestand 

dat u wilt overbrengen.
Klik op  om de muzieklijst weer te geven.

Klik op  om de videolijst weer te geven.
Klik op  om de afbeeldingenlijst weer te 
geven.
Klik op  om de ETC-lijst weer te geven. 
De ETC-lijst bevat andere bestandstypen 
(bijvoorbeeld .txt) dan muziek-, afbeeldings- en 
videobestanden.

4. Klik op <Add File> (Bestand toevoegen) 
onder in <Media Studio>.

Het venster <Open> (Openen) wordt 
weergegeven.

5. Selecteer de bestanden die u wilt toevoegen 
en klik op <Open> (Openen).

De bestanden worden aan de lijst aan de 
linkerzijde van het scherm <Media Studio> 
toegevoegd.

6. Selecteer het bestand dat u wilt overzetten in 
de lijst aan de linkerkant.

7. Klik op het pictogram  .
Het geselecteerde bestand wordt overgebracht 
naar de speler.

[YP-P2 [MTP]]

Portable [YP-P2[MTP]]3

4

5

7

6 [YP-P2 [MTP]]

Portable [YP-P2[MTP]]
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
SAMSUNG MEDIA STUDIO (vervolg)

Koppel de USB-kabel niet los tijdens de bestandsoverdracht. Loskoppelen van 
de USB-connector tijdens bestandsoverdracht kan leiden tot beschadiging van de 
speler en de computer.
Sluit de speler rechtstreeks op de computer aan in plaats van via een USB-hub. 
Zo voorkomt u een instabiele verbinding.

Wanneer u een videobestand naar de speler overbrengt met <Media Studio>, wordt 
het bestand vóór de overdracht geconverteerd naar de indeling SVI. Tevens wordt 
de bestandsgrootte aangepast. 
Wanneer u een afbeelding naar de speler overbrengt met <Media Studio>, wordt 
het bestand vóór de overdracht geconverteerd naar JPG-indeling. Tevens wordt de 
bestandsgrootte aangepast.
Een afbeelding die u naar de speler overbrengt zonder <Media Studio>, kan er op 
het scherm anders uitzien dan de originele afbeelding.
Zolang de speler is aangesloten op de computer, zijn alle functies uitgeschakeld.
Als u de USB-kabel op de computer aansluit terwijl de batterij bijna leeg is, wordt de 
speler eerst enkele minuten opgeladen voordat de verbinding met de computer tot 
stand wordt gebracht.
Samsung Media Studio heeft een uitgebreide Help-functie. Als u het antwoord op 
uw vraag over Media Studio hier niet kunt vinden, klikt u op <MENU> <Help>
<Help> aan de bovenkant van het venster van <Media Studio>.
Wat is SVI?
Samsung Audio Video Interleaving (SVI) is een nieuwe video-indeling, ontwikkeld 
door en in beheerd van Samsung.

LET OP

OPMERKING
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een video bekijken
Voordat u begint! - Breng videobestanden over naar de speler met <Media Studio>.

Zie pagina 37.
De oortelefoon aansluiten, de speler aanzetten en de batterij 
controleren.

Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

1. Tik op het pictogram  in het hoofdmenu.
De lijst met video’s wordt weergegeven.

2. Selecteer een af te spelen videobestand en tik erop.
Het geselecteerde videobestand wordt horizontaal afgespeeld.

PAUZEREN
1. Tik tijdens het afspelen op het pictogram [ ].

Het afspelen van de video wordt gepauzeerd.

2. Tik op het pictogram [ ] om het afspelen te hervatten.
De video wordt afgespeeld vanaf het punt waar het afspelen is gestopt. 

Informatie en pictogrammen verdwijnen na enige tijd bij het afspelen van video’s. 
Tik op het scherm als u deze informatie en pictogrammen weer wilt weergeven.
Wanneer u een videobestand naar de speler overbrengt met <Media Studio>, wordt 
het bestand vóór de overdracht geconverteerd naar de indeling SVI. Tevens wordt 
de bestandsgrootte aangepast.

OPMERKING

OPMERKING
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NAAR EEN SPECIFIEK FRAME GAAN
Instructie 1
1. Houd het pictogram [ , ] in de 

horizontale weergave tijdens het 
afspelen kort ingedrukt.

Hierdoor kunt u in het huidige 
videobestand vooruit en achteruit 
spoelen.

2. Haal uw vinger van het pictogram 
als u naar de gewenste positie hebt 
gespoeld.

De video begint op dit punt af te spelen.

Instructie 2
Tik op het punt op de afspeelstatusbalk waar u het afspelen wilt starten.

De video wordt afgespeeld vanaf het door u geselecteerde punt.

Door uw vinger op het scherm naar links of rechts te bewegen spoelt u 
vooruit of achteruit, afhankelijk van de instelling voor horizontale slag. Zie 
pagina 44.

OPMERKING

Video Track 1
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HET VORIGE VIDEOBESTAND AFSPELEN
Instructie 1
Tik binnen 3 seconden nadat de huidige 
video is begonnen met afspelen op het 
pictogram [ ].
Tik binnen 3 seconden nadat de huidige 
video is begonnen met afspelen twee keer 
op het pictogram [ ].

Instructie 2
Beweeg uw vinger naar rechts.

De vorige video wordt nu afgespeeld.

HET VOLGENDE VIDEOBESTAND AFSPELEN
Instructie 1
Klik op het pictogram [ ].

Instructie 2
Beweeg uw vinger naar links.

De volgende video wordt nu afgespeeld.

Video Track 1

Instructie 2

Instructie 2

Video Track 1
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HET VIDEOMENU GEBRUIKEN
Een bladwijzer instellen
Als u een bladwijzer instelt voor een bepaalde scène, kunt u die 
opnieuw bekijken wanneer u maar wilt.
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <Bookmark> (Bladwijzer).
Het menu <Bookmark> (Bladwijzer) wordt 
weergegeven.

3. Tik op <Add> (Toev)
Op het huidige punt wordt een bladwijzer 
ingesteld.
U ziet het symbool [ | ] op de afspeelstatusbalk.

Het venster Overschrijven verschijnt als er al eerder een bladwijzer is ingesteld. Als 
u <Yes>(Ja) selecteert, wordt de eerder ingestelde bladwijzer verwijderd en wordt 
er een nieuwe bladwijzer toegevoegd.
U kunt één bladwijzer per video instellen met een maximum van 100 bladwijzers.
Het punt van de bladwijzer kan iets afwijken van het eigenlijke punt.

Naar de bladwijzer gaan (afspelen)/de bladwijzer verwijderen
1. Tik op het pictogram [ ] in het video-

afspeelscherm.
Het menu <Video> wordt weergegeven.

2. Tik op <Bookmark> (Bladwijzer).
Het menu <Bookmark> (Bladwijzer) wordt 
weergegeven.

3. Tik op <Go to>(Ga naar) of 
<Delete>(Wissen).

Als u <Go to>(Ga naar) selecteert, gaat u naar de geselecteerde bladwijzer en 
wordt deze afgespeeld.
Met <Delete>(Wissen) verwijdert u de geselecteerde bladwijzer uit het 
videobestand.

Tik op het pictogram [ ] om het menu te verlaten.

OPMERKING

OPMERKING
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HET VIDEOMENU GEBRUIKEN (Vervolg)
De Digital Natural Sound-engine (DNSe) instellen
De juiste geluidsweergave voor elk videogenre selecteren.
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <DNSe> (DNSe)
Het menu <DNSe> wordt weergegeven.

3. Tik op een gewenste DNSe.
U kunt kiezen uit <Normal>(Normaal), 
<Drama>(Drama) en <Action>(Hand.).

Wat is SVI?
Digital Natural Sound Engine (DNSe) is een functie voor geluidseffecten voor MP3-
spelers die is ontwikkeld door Samsung. Dit biedt verschillende geluidsinstellingen 
voor het verbeteren van het type muziek waar u naar luistert.

De horizontale slag instellen
U kunt snel vooruit door een bestand bladeren met verschillende intervallen als u het scherm 
links of rechts aanraakt. Sla een heel bestand over of meerdere seconden tegelijkertijd.
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <Horizontal Stroke> (Horizontale slag).
Het menu <Horizontal Stroke>(Horizontale 
slag) wordt weergegeven.

3. Tik op de gewenste horizontale slag.
U kunt kiezen uit <1 File>(1 best.), <Seek>(Zoeken), 
<10sec Skip>(10sec Oversl.), <30sec Skip>(30sec Oversl.) en <1min Skip>(1min Overslaan.).
Links : vooruit, afhankelijk van de intervalinstelling van de horizontale slag.
Rechts : achteruit, afhankelijk van de intervalinstelling van de horizontale slag.
<1 File>(1 best.): Als u <Horizontal Stroke> (Horizontale slag) instelt op <1 File>(1 best.), wordt 
het vorige of volgende bestand geselecteerd.
Als u de optie Seek <Searching>(Zoeken) instelt, kunt u door de afspeelsnelheden <x2> 
<x4>  <x8> bladeren door uw vinger naar links of rechts te bewegen.

Het interval van de horizontale slag kan verschillen van het eigenlijke interval voor overslaan.

Bookmark

DNSe

Horizon

Screen

Normal

Drama

Action

Bookma

DNSe

Horizon

Screen

1 File
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OPMERKING

OPMERKING
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HET VIDEOMENU GEBRUIKEN (Vervolg)
Het schermformaat selecteren
U kunt het weergaveformaat voor het afspelen van video’s selecteren.
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <Screen Size> (Schermformaat).
Het menu <Screen Size> 

(Schermformaat) wordt weergegeven.

3. Tik op het gewenste schermformaat.
U kunt kiezen uit <Actual>(Werkelijk), <Standard>(Standaard), 
<Full>(Volledig) en <Zoom>(Zoom).

Het menu Schermformaat

             Standard <Standaard>      Full <Volledig>          <Zoom>(Zoom)

Voor sommige videobestanden wordt het menu <Screen Size> 
(Schermformaat) of andere verwante menu’s mogelijk niet weergegeven.

Bookma

DNSe

Horizon

Screen

Actual

Standard

Full

Zoom

OPMERKING
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HET VIDEOMENU GEBRUIKEN (Vervolg)
Voordat u begint! - Gebruik alleen stereokoptelefoons die zijn gecertifi ceerd 
voor Bluetooth. Controleer of uw Bluetooth-stereokoptelefoon is geregistreerd. 
<Connect to Headset> (Verb. met koptelefoon) wordt weergegeven als er een 
geregistreerde koptelefoon aanwezig is. Zie <Een Bluetooth-stereokoptelefoon 
gebruiken> voor meer informatie. Zie pagina 88.

Verbinding maken met een Bluetooth-stereokoptelefoon
U kunt tijdens het afspelen van video rechtstreeks verbinding maken 
met een geregistreerde Bluetooth-koptelefoon.
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <Connect to Headset> (Verb. 
met koptelefoon).

Als <Bluetooth Mode>(Bluetooth Mode) is 
ingesteld op <Off>(Uit), wordt dit gewijzigd in 
<On>(Aan).
Wanneer de verbinding tot stand is gebracht, 
ziet u het pictogram [ ] op het scherm.
U kunt genieten van audio en video via de Bluetooth-koptelefoon.

De verbinding met de Bluetooth-stereokoptelefoon verbreken
1. Tik tijdens de gewenste scène op het 

pictogram [ ].
Het menu <Video> wordt weergegeven.

2. Tik op <Disconnect Headset> 
(Headset loskoppelen).

De verbinding met de Bluetooth-koptelefoon 
is verbroken.

<DNSe> (DNSe) wordt niet weergegeven 
terwijl de speler verbinding maakt met de Bluetooth-stereokoptelefoon.
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Songs 1/52

Audio Track 1

muziek beluisteren
Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij 

controleren.
Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

LUISTEREN OP CATEGORIE

1. Tik op het pictogram  in het hoofdmenu.
De <Music> (Muziek) lijst wordt weergegeven.

2. Selecteer een gewenst item in de muzieklijst en tik erop.
Het muziekbestand wordt weergegeven.

3. Selecteer een af te spelen muziekbestand en tik erop.
De muziek wordt afgespeeld.

OPMERKING
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LUISTEREN OP CATEGORIE (vervolg)
Muzieklijst
Bestandsinformatie, waaronder naam van de artiest, naam van het album, titel van het 
nummer en het genre worden weergegeven, gebaseerd op de ID3-taginformatie bij 
het muziekbestand. Bestanden zonder ID3-Tag worden weergegeven als <Unknown> 
(onbekend).

Now Playing (Nu Speelt) : Speelt een recent afgespeeld bestand of gaat naar het 
afspeelscherm van het huidige bestand.
Artists (Artiest) : Afspelen op artiest                                                
Albums (Album) : Afspelen op album
Songs (Nummers) : Afspelen in numerieke of alfabetische volgorde           
Genres (Genre) : Afspelen op genre
Playlists : Afspelen op afspeellijst
Music Browser (Muziekbrowser) : Geeft alle muziekbestanden in de muziekmap weer.

De speler kan MP3- en WMA-muziekbestanden afspelen.
MP1- of MP2-bestanden waarvan alleen de extensie is gewijzigd in MP3, kunnen 
niet worden afgespeeld op de speler.
Wat is een ID3-parameter?
Dit is een tag in een MP3-bestand die informatie bevat over het bestand, zoals de 
titel, de artiest, het album, het jaar, het genre en een veld voor opmerkingen.

OPMERKING
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PAUZEREN
1. Tik op het pictogram [ ] of druk op de knop  tijdens het afspelen 

van muziek.
Het afspelen van de muziek wordt onderbroken.

2. Tik op het pictogram [ ] of druk nogmaals op de knop .
De muziek wordt afgespeeld vanaf het punt waar het afspelen is gestopt.

AFSPELEN VANAF HET BEGIN VAN HET HUIDIGE NUMMER
1. Tik na 3 seconden afspelen op het pictogram [ ].

Het huidige nummer wordt afgespeeld vanaf het begin.

HET VORIGE NUMMER AFSPELEN
Instructie 1
Tik binnen 3 seconden afspelen op het pictogram
[ ].
Tik na 3 seconden afspelen twee keer op het 
pictogram [ ].

Instructie 2
Beweeg uw vinger naar rechts.

Het vorige nummer wordt afgespeeld.

Wanneer u VBR-bestanden afspeelt, wordt het vorige nummer mogelijk niet 
afgespeeld, ook al tikt u binnen 3 seconden op het pictogram [ ].

Songs 52/52

Audio Track 0

Instructie 2

LET OP
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HET VOLGENDE NUMMER AFSPELEN
Instructie 1
Klik op het pictogram [ ].

Instructie 2
Beweeg uw vinger naar links.

Het volgende nummer wordt afgespeeld.

ZOEKEN BINNEN EEN NUMMER
Instructie 1
1. Houd het pictogram [ ] of [ ] enige tijd 

ingedrukt terwijl het geselecteerde nummer wordt 
afgespeeld.

Er wordt gezocht richting het begin of het einde van 
het nummer.

2. Laat het pictogram los op het punt waar u wilt 
starten.

Het nummer wordt afgespeeld vanaf het moment dat u 
het pictogram loslaat.

Instructie 2
Tik op een gewenst punt in de afspeelstatusbalk.

Door uw vinger op het scherm naar links of rechts te bewegen spoelt u 
vooruit of achteruit, afhankelijk van de instelling voor horizontale slag. 
Zie pagina 62

Songs 1/52

Audio Track 1

Instructie 2
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EEN AFSPEELLIJST MAKEN MET SAMSUNG MEDIA 
STUDIO
Met <Media Studio> kunt u uw eigen collectie of afspeellijst met 
geluidsbestanden samenstellen.

Voordat u begint! - Sluit de speler aan op de computer.
Media Studio moet zijn geïnstalleerd op de computer.

Een afspeellijst maken

1. Klik op <Playlists> boven in <Media Studio>.
Het venster <Playlists> wordt weergegeven.

2. Klik onder in het venster op <New Playlists> (Nieuwe 
afspeellijsten).

Het venster <Create Playlists> (Afspeellijsten maken) wordt weergegeven.

3. Geef een titel voor de afspeellijst op en klik op [OK].
De nieuwe afspeellijst krijgt een naam en wordt opgeslagen in het gedeelte 
<Playlists> in <Media Studio>.

2

1
[YP-P2 [MTP]]

OK 3

Portable [YP-P2[MTP]]
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EEN AFSPEELLIJST MAKEN MET SAMSUNG MEDIA 
STUDIO (vervolg)

Muziekbestanden toevoegen aan een afspeellijst die 
u hebt gemaakt

1. Klik op <My PC> (Mijn PC) boven in <Media Studio>.
Het venster <My PC> (Mijn PC) wordt weergegeven.

2. Klik op <Playlists> in de rechterhoek van het venster.
Het venster <Playlists> wordt weergegeven.

3. Dubbelklik op een album in het rechtervenster.
4. Selecteer in het venster <My PC> (Mijn PC) de bestanden die u wilt 

overbrengen.
5. Klik op het symbool .

De geselecteerde bestanden worden aan de afspeellijst toegevoegd.

5

1

3
4

2
[YP-P2 [MTP]]
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EEN AFSPEELLIJST MAKEN MET SAMSUNG MEDIA 
STUDIO (vervolg)

Een afspeellijst kopiëren naar de speler met Media 
Studio

1. Klik op <Playlists> boven in <Media Studio>.
Het venster <Playlists> wordt weergegeven.

2. Selecteer een afspeellijst in het gedeelte <Playlists>.
3. Klik op het symbool .

De geselecteerde afspeellijst wordt map voor map overgezet naar 
<File Browser> (Bestandsbrowser)  <Playlists>.

De speler kan maximaal 400 afspeellijsten afspelen met maximaal 400 
muziekbestanden per afspeellijst.OPMERKING

1
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Portable [YP-P2[MTP]]
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EEN AFSPEELLIJST OP UW MP3-SPELER MAKEN
Als u al bestanden hebt gedownload naar uw MP3-speler, kunt u een afspeellijst 
met ‘Favorieten’ samenstellen zonder Media Studio op uw pc.
1. Tik op het pictogram  in het hoofdmenu.
2. Selecteer <Music>(Muziek) en tik erop.

De lijst met muziekbestanden wordt weergegeven.

3 Selecteer een bestand om toe te voegen aan de 
afspeellijst en tik op het pictogram [ ].

Het menu Afspeellijst wordt weergegeven.

4. Tik op <Add to Playlist> (Toev. aan afsp.).
<Playlist 1>(Afspeellijst 1) tot en met <Playlist 5>(Afspeellijst 5) 
wordt weergegeven.

5. Tik op het afspeellijstnummer waar u het geselecteerde 
bestand aan wilt toevoegen.

Het geselecteerde bestand wordt toegevoegd aan de afspeellijst.
U kunt de afspeellijst bekijken via <Music>(Muziek) 
<Playlists>  <Playlist 1>(Afspeellijst 1) tot en met <Playlist 
5>(Afspeellijst 5) in het hoofdmenu.

U kunt maximaal 200 muziekbestanden toevoegen aan elke 
afspeellijst (<Playlist 1>(Afspeellijst 1) tot en met <Playlist 
5>(Afspeellijst 5)).

OPMERKING
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EEN AFSPEELLIJST AFSPELEN
1. Tik op het pictogram  in het hoofdmenu.

De muzieklijst wordt weergegeven.

2. Selecteer <Playlists> en tik erop.
De afspeellijsten worden weergegeven.

3. Selecteer de gewenste afspeellijst en tik erop.
De muziekbestanden van de geselecteerde afspeellijst worden 
weergegeven.
Als geen afspeellijst wordt gevonden, wordt de melding <No 
File> (Geen bestanden.) op het scherm weergegeven.

4. Selecteer een af te spelen muziekbestand en tik erop.
Het muziekbestand wordt afgespeeld.

Zie pagina’s 51 en 53 voor meer informatie over hoe u een 
afspeellijst overbrengt met <Media Studio>.
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EEN BESTAND VERWIJDEREN UIT DE AFSPEELLIJST
1. Tik op het pictogram  in het hoofdmenu.

De muzieklijst wordt weergegeven.

2. Selecteer <Playlists> en tik erop.
De afspeellijsten worden weergegeven.

3. Selecteer de gewenste afspeellijst en tik erop.
De muziekbestanden van de geselecteerde afspeellijst worden 
weergegeven.

4. Selecteer een bestand om te verwijderen uit de afspeellijst 
en tik op het pictogram [ ].

Het menu Afspeellijst wordt weergegeven.

5. Tik op <Delete from Playlist> (Verw. uit afspeellijst).
Het bevestigingsvenster voor verwijderen wordt weergegeven.

6. Tik op <Yes>(Ja).
Het geselecteerde bestand wordt verwijderd uit de afspeellijst.

Het geselecteerde bestand kan niet worden verwijderd als deze wordt afgespeeld.

ALLE BESTANDEN VERWIJDEREN UIT DE AFSPEELLIJST
Volg stap 1 tot en met 3 hierboven.
4. Tik op het pictogram [ ].

Het menu Afspeellijst wordt weergegeven.

5. Tik op <Delete All from Playlist> (Alles verw. uit afsp.lijst).
Het bevestigingsvenster voor verwijderen wordt weergegeven.

6. Tik op <Yes>(Ja).
Alle bestanden worden uit de afspeellijst verwijderd.

Song 1
Song 4

Song 6

Song 8

Song 9
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HET MUZIEKMENU GEBRUIKEN
Via het menu Muziek heeft u controle over alle facetten van het luisteren 
naar muziek; van het herhalen van nummers en albums tot het kiezen van de 
schermachtergrond tijdens het afspelen van muziek.

Het geluidseffect instellen
U kunt genieten van helderder geluid.
1. Tik op het pictogram [ ] in het 

muziekafspeelscherm.
Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op <Sound Effect>(Geluidseffect).
Het menu <Sound Effect>(Geluidseffect) wordt 
weergegeven.

3. Tik op het gewenste geluidseffect.
U kunt kiezen uit <Street Mode>(Straatmodus) en 
<Clarity>(Helderheid).

Opties voor geluidseffecten
Street Mode (Straatmodus) : In deze modus kunt u ook buiten luisteren naar 
muziek met een helder geluid, doordat straatgeluiden gefi lterd worden. U kunt 
kiezen uit <Off>(Uit) en <On>(Aan).
Clarity (Helderheid) : Geniet van een helderder geluid met verbeterde kwaliteit. 
Kies uit 0-2 <0-2>.

Tik op het pictogram [ ] om het menu te verlaten.

Sound Effect
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De Digital Natural Sound-engine (DNSe) instellen (DNSe)
Hier selecteert u de juiste geluidsweergave voor elk muziekgenre.
1. Tik op het pictogram [ ] in het 

muziekafspeelscherm.
Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op <DNSe> (DNSe).
Het menu <DNSe> (DNSe) wordt weergegeven.

3. Tik op een van de DNSe-opties.
U kunt kiezen uit <Normal>(Normaal), <Studio>, 
<Rock>, <Classical>(Klassiek), <Jazz>, <Ballad>, 
<Club>, <Rhythm & Blues>, <Dance>, <Concert 
Hall>(Concertzaal) en <Hall>.
U kunt <EQ> (EQ) en <3D&Bass>(3D en bas) 
instellen als u <User> (Gebruiker) hebt geselecteerd. Zie pagina 59

U kunt DNSe ook instellen door het pictogram [DNSe] aan te raken in het 
muziekafspeelscherm.
Wat is DNSe?
Digital Natural Sound Engine (DNSe) is een functie voor geluidseffecten 
voor MP3-spelers die is ontwikkeld door Samsung. Dit biedt verschillende 
geluidsinstellingen voor het verbeteren van het type muziek waar u naar 
luistert.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De Digital Natural Sound-engine (DNSe) instellen (DNSe)
<3D&Bass> (3D en bas)
Met deze optie stelt u 3D-geluidseffecten en extra bas in.
1 Tik op het pictogram [ ] van <User>(Gebruiker).

Het scherm <User>(Gebruiker) wordt weergegeven.
2. Tik op <3D&Bass> (3D en bas).

Het instellingenscherm <3D&Bass>(3D en bas) wordt 
weergegeven.

3. Selecteer <3D> (3D) of <Bass>(Bas) en tik op 
het pictogram [ , ] om het gewenste punt in te 
stellen.

Voor <3D> (3D) en <Bass>(Bas) kunt u kiezen uit <0-4>.
4. Tik op <OK>.

De instelling is voltooid.

<EQ> (EQ)
U kunt individuele frequenties aanpassen om het geluid volgens uw 
voorkeur in te stellen.
1 Tik op het pictogram [ ] van <User>(Gebruiker).

Het scherm <User>(Gebruiker) wordt weergegeven.
2. Tik op <EQ> (EQ).

Het instellingenscherm <EQ> wordt weergegeven.
3. Tik op het pictogram [  ,  ] om de frequentie 

te selecteren die u wilt aanpassen, en tik op 
het pictogram [ , ] om het niveau van de 
geselecteerde frequentie aan te passen.

De frequenties die kunnen worden aangepast, zijn 
<60Hz>, <150Hz>, <400Hz>, <1.1kHz>, <3.5kHz>, 
<8kHz> en <14kHz>.
U kunt kiezen uit <–10 - +10> voor het niveau van de geselecteerde frequentie.

4. Tik op <OK>.
De instelling is voltooid.

User

OK Cancel

+10

0

-10

User

OK Cancel



60 _ muziek beluisteren

HET MUZIEKMENU GEBRUIKEN (Vervolg)
De afspeelmodus instellen
De afspeelmodus selecteren, zoals de herhaalinstellingen.
1. Tik op het pictogram [ ] in het 

muziekafspeelscherm.
Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op <Play Mode>(Afspeelmodus).
Het menu <Play Mode>(Afspeelmodus) wordt 
weergegeven.

3. Tik op de gewenste afspeelmodus.
U hebt de keuze uit <Normal>(Normaal), 

<Repeat>(Herhaal), <Repeat One>(Eén herhalen) of 
<Shuffl e> (Shuffl e).

Opties voor afspeelmodus
Normal (Normaal) : Alle nummers worden één keer in de normale volgorde 
afgespeeld.
Repeat (Herhaal) : Alle bestanden worden herhaald.
Repeat One (Eén herhalen) : Eén bestand wordt herhaald..
Shuffl e (Shuffl e): Bestanden worden in willekeurige volgorde afgespeeld.

Sound Effect

DNSe

Play Mode

Music Play Screen

Add to Alarm

Horizontal Stroke

Songs 2/52

Normal

Repeat

Repeat One

Shuffl e

Audio Track 1



muziek beluisteren _ 61

HET MUZIEKMENU GEBRUIKEN (Vervolg)
Het muziekafspeelscherm selecteren
Kies een achtergrondafbeelding uit de geboden mogelijkheden of kies 
uw eigen achtergrondafbeelding. Deze wordt weergegeven terwijl u 
naar muziek luistert.
1. Tik op het pictogram [ ] in het muziekafspeelscherm.

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op <Music Play Screen> (Muziekafspeelscherm).
Het menu <Music Play Screen> 
(Muziekafspeelscherm) wordt weergegeven.

3. Tik op het pictogram [  ,  ] om een 
muziekafspeelscherm te selecteren en tik op <OK>.

U kunt kiezen uit <Type 1> (Type 1), <Type 2> (Type 
2), <Type 3> (Type 3), <Type 4> (Type 4), <Album 
Info.>(Albuminfo.) en <Album Art>(Albumontw.).

Opties voor muziekafspeelscherm
Type 1 ~ Type 4 (Type 1 ~ Type 4) : U kunt een muziekafspeelscherm naar 
keuze selecteren.
Album Info. (Albuminfo.) : Informatie over de naam van de artiest, het album 
en het genre wordt weergegeven als ID3-taginformatie is opgeslagen in het 
muziekbestand.
Album Art (Albumontw.) : Een afbeelding van de cd-hoes wordt weergegeven 
als deze informatie is opgenomen in de ID3-taginformatie van het 
muziekbestand. Afbeeldingen van cd-hoesjes worden ondersteund als deze niet 
groter zijn dan 200 pixels (horizontaal) x 200 pixels (verticaal).

Wat is een ID3-parameter?
Dit is een tag in een MP3-bestand die informatie bevat over het bestand, 
zoals de titel, de artiest, het album, het jaar, het genre en een veld voor 
opmerkingen.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Alarmgeluiden toevoegen
U kunt uw favoriete muziekbestanden toevoegen aan de lijst met 
wekkergeluiden, zodat u dit de volgende keer dat het alarm afgaat, 
hoort. Zie pagina 82 over het instellen van het alarm.
1. Selecteer een muziekbestand om toe te voegen aan 

de alarmgeluiden en tik op het pictogram [ ].
Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op <Add to Alarm> (Bijvoegen aan Alarm).
Het venster Opslaan wordt weergegeven. 

3. Tik op <OK>.
De geselecteerde muziek wordt toegevoegd aan de 
lijst met alarmgeluiden.
Er kan één muziekbestand worden toegevoegd als 
alarmgeluid.

De horizontale slag instellen
U kunt het slaginterval voor het bladeren door muziekbestanden instellen 
door uw vinger op het scherm naar links of naar rechts te bewegen.
1. Tik op het pictogram [ ] in het

muziekafspeelscherm.
Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op <Horizontal Stroke> (Horizontale slag).
Het menu <Horizontal Stroke> (Horizontale slag) 
wordt weergegeven.

3. Tik op de gewenste horizontale slag.
U kunt kiezen uit <1 File>(1 best.), <10sec Skip>(10 
sec Oversl), <30sec Skip>(30 sec Oversl) en <1min 
Skip>(1 min Overslaan).

Als het bestand is opgenomen met een variabele 
bitrate, komt de horizontale slag mogelijk niet precies 
overeen met wat u hebt ingesteld.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Voordat u begint! - Gebruik alleen stereokoptelefoons die zijn gecertifi ceerd voor 
Bluetooth. Controleer of uw Bluetooth-stereokoptelefoon is geregistreerd. <Connect 
to Headset> (Verb. met koptelefoon) wordt weergegeven als er een geregistreerde 
koptelefoon aanwezig is. Zie <Een Bluetooth-stereokoptelefoon gebruiken> voor 
meer informatie. Zie pagina 88

Verbinding maken met een Bluetooth-stereokoptelefoon
U kunt tijdens het afspelen van muziek rechtstreeks verbinding maken 
met de geregistreerde Bluetooth-koptelefoon.
1. Tik op het pictogram [ ] in het 

muziekafspeelscherm.
Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op <Connect to Headset>(Verb. met 
koptelefoon).

Als <Bluetooth Mode> is ingesteld op <Off>(UIT), wordt dit 
gewijzigd in <On>(AAN).
Wanneer de verbinding tot stand is gebracht, ziet u het 
pictogram [ ] op het scherm.
U kunt met de Bluetooth-koptelefoon naar muziek luisteren.

De verbinding met de Bluetooth-
stereokoptelefoon verbreken
1. Tik op het pictogram [ ] in het 

muziekafspeelscherm.
Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op <Disconnect Headset> (Headset 
loskoppelen).

De verbinding met de Bluetooth-koptelefoon is verbroken.

<Sound Effect>(Geluidseffect) en <DNSe> (DNSe) worden 
niet weergegeven terwijl de speler verbinding maakt met 
de Bluetooth-stereokoptelefoon.
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afbeeldingen bekijken
Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.
Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

1. Tik op het pictogram  in het hoofdmenu.
Het voorbeeldscherm voor afbeeldingen wordt weergegeven.

2. Selecteer een afbeelding en tik erop.
De geselecteerde afbeelding wordt weergegeven.
Tik op het pictogram [ ] om naar het vorige scherm te gaan.

Naar de vorige/volgende afbeelding gaan
Tik op het pictogram [  ,  ] in het scherm voor afbeeldingsweergave.

De vorige/volgende afbeelding wordt weergegeven.
Informatie en pictogrammen verdwijnen na enige tijd bij de weergegeven afbeelding. Tik 
op het scherm als u deze informatie en pictogrammen weer wilt weergeven.
Het pictogram Vorige/Volgende afbeelding [  ,  ] wordt weergegeven als u één keer op 
het scherm tikt. Als u nogmaals op het scherm tikt worden zowel afbeeldingsinformatie 
als pictogrammen weergegeven.
JPG-bestanden zonder miniatuurweergave of onjuiste miniatuurweergave-informatie 
worden weergegeven [  ].
Sommige afbeeldingen worden langzamer weergegeven dan andere.
Wanneer u een afbeelding naar de speler overbrengt met <Media Studio>, wordt 
het bestand vóór de overdracht geconverteerd naar JPG-indeling. Tevens wordt de 
bestandsgrootte aangepast.
U kunt ook een afbeelding zoeken met behulp van de <File Browser>(Bestandsbrowser). 
Zie pagina 23.
Ook als u <Pictures>(Afbeeld.) selecteert om een afbeelding te bekijken, kunt u muziek 
blijven afspelen.

OPMERKING

OPMERKING
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HET AFBEELDINGSMENU GEBRUIKEN
Een diashow bekijken
Instructie 1
Tik op het pictogram [ ] in het voorbeeldscherm.

Het pictogram [ ] verschijnt op het scherm en de 
diashow begint.

Instructie 2
1. Tik op het pictogram [ ] in het scherm voor 

afbeeldingsweergave..
Het menu <Pictures>(Afbeeld.) wordt weergegeven.

2. Tik op <Start Slideshow> (Begin diashow).
Het pictogram [ ] verschijnt op het scherm en de 
diashow begint.

De afspeelsnelheid van de diashow instellen
1. Tik op het pictogram [ ] in het scherm voor 

afbeeldingsweergave.
Het menu <Pictures>(Afbeeld.) wordt weergegeven.

2. Tik op <Slideshow Speed> (Snelheid diavoorst.).
Het menu <Slideshow Speed> (Snelheid diavoorst.) 
wordt weergegeven.

3. Tik op de gewenste snelheid.
U kunt kiezen uit <Slow>(Traag), <Normal>(Normaal) 
en <Fast>(Snel).

Tik op het pictogram [ ] om het menu te verlaten.
OPMERKING
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
De diashow beëindigen
Tik op het scherm in de diashowmodus.

De diashow wordt stopgezet.

Een afbeelding als achtergrondafbeelding selecteren
U kunt een afbeelding naar keuze instellen als achtergrond voor het 
scherm.
1. Selecteer een afbeelding om in te stellen als 

achtergrondafbeelding en tik op het pictogram [ ].
Het menu <Pictures>(Afbeeld.) wordt weergegeven.

2. Tik op <Select as My Skin> (Select. als Mijn 
huid).

Het venster Opslaan wordt weergegeven.

3. Tik op <Yes> (Ja).
De geselecteerde afbeelding wordt ingesteld als 
achtergrondafbeelding.

Start Slideshow

Slideshow Speed

Select as My Skin
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
De afbeeldingsweergavemodus selecteren
1. Tik op het pictogram [ ] in het scherm voor 

afbeeldingsweergave.
Het menu <Pictures>(Afbeeld.) wordt weergegeven.

2. Tik op <View Mode> (Weergavemodus).
Het menu <View Mode> (Weergavemodus) wordt 
weergegeven.

3. Tik op de gewenste modus.
U kunt kiezen uit <Auto> (Auto) en <Horizontal>
(Horizontaal).
Als u <Horizontal>(Horizontaal) selecteert, wordt de 
afbeelding horizontaal weergegeven.

Een afbeelding vergroten
U kunt inzoomen op een afbeelding.
1. Tik op het pictogram [ ] in het scherm voor 

afbeeldingsweergave.
De afbeelding wordt vergroot.
Elke keer dat u op het pictogram [ ] drukt, wordt de 
afbeelding vergroot volgens de stappen <x2>  <x3> 

 <x4>.
Tik op het pictogram [ ] om het vergroten van de 
afbeelding te annuleren.

2. Beweeg uw vinger op het scherm in de gewenste 
richting om de afbeelding te verplaatsen. Zie 
pagina 18

U kunt de ingezoomde afbeelding in elke richting verplaatsen.
Het kan iets langer duren om in te zoomen op een grote afbeelding.
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View Mode
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X2X2
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naar de FM-radio luisteren
Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij 
controleren.
Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het 
hoofdmenu weer te geven.

Tik op het pictogram  in het hoofdmenu.
FM-radio wordt ontvangen.

DE DEMPFUNCTIE GEBRUIKEN
Druk op de toets  terwijl u naar de radio luistert.

Het geluid wordt onderdrukt.
Druk nogmaals op de toets  om het luisteren te hervatten.

Sluit altijd de oortelefoon aan op uw speler als u frequenties 
zoekt of instelt. De oortelefoon wordt gebruikt als antenne 
voor het ontvangen van FM-radio.
In gebieden met slechte ontvangst worden mogelijk geen FM-
stations gevonden.
De Bluetooth-functie kan niet worden gebruikt tijdens het 
luisteren naar de radio.

OPMERKING
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FM-STATIONS ZOEKEN
1. Houd het pictogram [ , ] enige tijd ingedrukt en haal uw 

vinger van het scherm in de handmatige modus.
<Searching>(Zoeken,,,) wordt weergegeven op het scherm.
Het zoeken stopt bij de eerstvolgende frequentie nadat u de 
toets hebt losgelaten.

OF,

1. Tik op het pictogram [ , ] om de frequenties stap voor 
stap bij langs te gaan in de handmatige modus.

Wanneer u het pictogram indrukt wordt er naar een frequentie 
gezocht.

FM Radio

FM Radio

 Searching 
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HET MENU FM-RADIO GEBRUIKEN
Overschakelen naar de voorinstellingsmodus
Selecteer deze stand als u de opgeslagen FM-voorinstellingen wilt afzoeken.
1. Tik in de handmatige modus op het pictogram [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op <Go to Preset Mode> (Ga naar Preset Modus).
FM-radio wordt ontvangen.
De <PRESET> wordt op het scherm weergegeven.

Als er geen frequenties zijn voorgeprogrammeerd, 
wordt <Preset list does not exist>(Lijst preselectie 
bestaat niet) weergegeven. De speler schakelt niet over 
naar de voorinstellingsmodus.
Als <Default Set> (Standaard instellen) wordt 
geselecteerd in <Settings>(Instellingen)  <System> 
(Systeem), worden de opgeslagen voorgeprogrammeerde lijsten verwijderd.
Voorgeprogrammeerde frequenties worden opgeslagen in numerieke volgorde.

Overschakelen naar de handmatige stand
Selecteer deze stand als u de FM-band handmatig per frequentie wilt 
afzoeken.
1. Tik in de voorinstellingsmodus op het pictogram [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op <Go to Manual Mode>(Ga naar Handm.Modus).
De <MANUAL> wordt op het scherm weergegeven.

OPMERKING

FM Radio

FM Radio



naar de FM-radio luisteren _ 71

HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Stations opslaan in het voorkeuzegeheugen
U kunt maximaal 30 stations opslaan in het geheugen van uw MP3-
speler en deze vervolgens met één druk op de knop oproepen. Laat de 
MP3-speler met het handmatige proces alleen de zenders kiezen die u 
wilt, of sla automatisch alle gevonden lokale zenders op.
Manual (Handmatig) : alleen de stations kiezen die u wilt opslaan
1. Tik op het pictogram [ , ] om een in te stellen 

frequentie te selecteren in de handmatige modus 
en tik op het pictogram [ ].

2. Tik op <Add to Preset> (Toev. aan voorinst.).
Het geselecteerde station wordt ingesteld als 
voorkeuzestation.

Als een bepaalde frequentie al is 
voorgeprogrammeerd, wordt de melding <This preset 
already exists> (Deze preselectie bestaat reeds) 
weergegeven. De instelling wordt geannuleerd.

Luisteren naar een voorkeuzestation
Tik op het gewenste voorgeprogrammeerde nummer 
in de voorinstellingsmodus.

Het voorgeprogrammeerde nummer wordt 
geselecteerd en u kunt luisteren naar de 
radiofrequentie die is opgeslagen onder dat nummer.
Tik op het pictogram [ , ] om naar de vorige of 
volgende nummerlijst te gaan.

Tik op het pictogram [ ] om het menu te verlaten.

OPMERKING
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Stations opslaan in het voorkeuzegeheugen (vervolg)
Automatisch: automatisch alle zenders opslaan die de speler 
ontvangt
1. Tik op het pictogram [ ] in het FM-radioscherm.

Het menu <FM Radio> (FM-radio) wordt 
weergegeven.

2. Tik op <Auto Preset> (Autom. voorinst.).
Het menu <Auto Preset> (Autom. voorinst.) wordt 
weergegeven.

3. Tik op <OK>.
<Auto Preset> (Autom. voorinst.) verschijnt en 
maximaal 30 frequenties worden automatisch 
ingesteld.

Automatische voorinstelling annuleren
Als u de automatische voorinstelling wilt annuleren, drukt u tijdens het 
proces op een van de toetsen.

Het automatisch voorprogrammeren wordt geannuleerd en alleen de frequenties 
die tot op dat moment zijn ingesteld, worden opgeslagen.

U kunt de opgeslagen stations opnieuw instellen als u de MP3-speler in 
een andere stad gaat gebruiken. Als u de opgeslagen stations wilt wissen 
en nieuwe wilt laten opslaan, hoeft u het proces slechts te herhalen.
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Een voorkeuzestation wissen 
Volg de onderstaande stappen om frequenties te verwijderen terwijl u 
naar de radio luistert.
1. Tik in de voorinstellingsmodus op het 

pictogram [ ].
Het menu <FM Radio> (FM-radio) wordt 
weergegeven.

2. Tik op <Delete from Preset> (Verw. uit voorpr.).
De voorgeprogrammeerde frequenties worden 
weergegeven.

3. Selecteer een te verwijderen frequentie en tik 
erop.

Het bevestigingsvenster wordt weergegeven.

4. Tik op <Yes> (Ja).
Het geselecteerde voorgeprogrammeerde nummer wordt gewist. 
Als u het voorgeprogrammeerde nummer niet wilt verwijderen, selecteert u 
<NO> (Nee).

Als een voorgeprogrammeerde frequentie wordt verwijderd, worden de 
nummers van de volgende voorgeprogrammeerde zenders één stap 
opgeschoven.
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
FM-ontvangst instellen
Met de instelling <FM Sensitivity> (FM Gevoeligheid) 
kunt u de ontvangstgevoeligheid instellen.
1. Tik op het pictogram [ ] in het FM-radioscherm.

Het menu <FM Radio> (FM-radio) wordt weergegeven.
2. Tik op <FM Sensitivity> (FM Gevoeligheid).

Het menu <FM Sensitivity> (FM Gevoeligheid) wordt 
weergegeven.

3. Tik op de gewenste ontvangstgevoeligheid.
U kunt kiezen uit <High>(Hoog), <Middle>(Midden) en 
<Low>(Laag).
Als u <High> (Hoog) selecteert, worden meer 
frequenties ontvangen.

Een FM-regio instellen
U kunt een FM-regio instellen voor reizen naar het buitenland.
1. Tik op het pictogram [ ] in het FM-radioscherm.

Het menu <FM Radio> (FM-radio) wordt weergegeven.
2. Tik op <FM Region> (FM-regio).

Het menu <FM Region> (FM-regio) wordt weergegeven.
3. Tik op de gewenste FM-regio.

U kunt kiezen uit <Korea/US> (Korea/US), <Japan> 
(Japan) en <Other Countries> (Andere Landen).

Frequentiebereik naar regio
- Korea/US : FM-frequenties in 100 kHz-spelers zoeken tussen 87.5 

MHz~108.0 MHz.
- Japan : FM-frequenties in 100 kHz-spelers zoeken tussen 76.0 

MHz~108.0 MHz.
- Other Countries (Andere Landen) : FM-frequenties in 50 kHz-spelers 

zoeken tussen 87.50 MHz~108.00 MHz.
De FM-regio kan worden verwijderd of gewijzigd overeenkomstig de doelregio 
voor de speler. 
Opgeslagen radiofrequenties worden gewist wanneer u de instelling <FM 
Region> (FM-regio) op de speler wijzigt.
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de datacast gebruiken
Met <Media Studio> kunt u RSS-bloginformatie en -bestanden naar de speler 
overbrengen.

Wat is RSS?
RSS staat voor Rich Site Summary of Really Simple Syndication. RSS is een 
op XML gebaseerd systeem voor gegevensoverdracht dat wordt gebruikt om 
eenvoudiger informatie weer te geven op websites die vaak worden bijgewerkt, 
zoals nieuwssites en blogs.
Wat zijn datacasts?
U kunt automatisch bijgewerkte informatie ontvangen zonder telkens naar uw 
veelbezochte nieuws-, blog- en UCC-sites te hoeven gaan.
Voordat u begint! - Voordat u begint: Media Studio moet zijn geïnstalleerd op de 

computer. Zie pagina 36.

EEN KANAAL REGISTREREN
U kunt een nieuw kanaal maken door websites 
of webpagina’s met RSS-ondersteuning te 
registreren.
1. Klik op <Subscribe> (Aanmelden) onder 

aan het gedeelte <Datacasts> van 
<Media Studio>.

2. Voer een adres in bij <URL> en klik op 
< Next>( Volgende).

Als u een webadres kopieert en op Subscribe 
<Aanmelden> klikt, wordt het gekopieerde adres automatisch weergegeven bij <URL>.
Het venster voor bevestiging van de instellingen wordt weergegeven als het webadres 
ondersteuning biedt voor RSS.

3. Klik op <OK>.
Het gewenste kanaal is geregistreerd.
Het pictogram  wordt weergegeven in Datacasts voor het geregistreerde kanaal.

2

2

OPMERKING
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EEN NIEUWE KANAALGROEP MAKEN
U kunt een nieuwe groep maken om kanalen per categorie te beheren.
1. Klik op <New Group> (Nieuwe groep) onder 

aan het gedeelte <Datacasts> van <Media 
Studio>.

2. Typ een groepsnaam en beschrijving en klik op 
<OK>.

EEN DATACAST OVERBRENGEN VAN <MEDIA STUDIO>
Voordat u begint! - Sluit de speler aan op de computer. 

Media Studio moet zijn geïnstalleerd op de computer. Zie pagina 36.
1. <Media Studio> wordt automatisch gestart 

op het moment dat de speler wordt 
aangesloten op de computer.

Als het programma niet automatisch wordt 
gestart, dubbelklikt u op het <Media Studio>-
pictogram  op het bureaublad.

2. Klik op <Datacasts> boven in <Media 
Studio>.

De lijst met groepskanalen voor Datacasts 
wordt weergegeven.

3. Klik op het gewenste groepskanaal.
4. Klik op het gewenste kanaal.
5. Selecteer de melding dat u wilt overbrengen.
6. Klik op het pictogram .

De melding van het geselecteerde kanaal wordt overgebracht naar de speler in <File 
Browser>(Bestandsbrowser)  <Datacasts>.

Klik op  boven in <Media Studio> om naar het vorige scherm te gaan.
Als het bericht een bijlage bevat, kunt u in <Datacasts> in <Media Studio> 
de bijlage downloaden naar de speler. Het kan echter zijn dat de bijlage niet 
gedownload kan worden, afhankelijk van het beleid van de betreffende website.

OPMERKING
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DATACASTS WEERGEVEN
U kunt aan <Datacasts> toegevoegde kanaalberichten weergeven.

Voordat u begint! - Breng gewenste kanaalberichten over naar de speler met 
<Media Studio>. Zie pagina 76

Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

1. Tik op het pictogram  in het hoofdmenu.
De lijst met datacasts wordt weergegeven.

2. Selecteer de gewenste kanaaltitel en tik erop.
De titel is hetzelfde als die van het kanaal dat is toegevoegd aan 
<Datacasts> in <Media Studio>.

3. Selecteer de gewenste berichttitel en tik erop.

De lijst met bestanden wordt weergegeven.

pictogram  : Hoofdtekst van het overgebrachte bericht
pictogram  : Afbeeldingsbestand
pictogram  : Muziekbestand
pictogram  : Videobestand

4. Selecteer een bestand en tik erop.
Het geselecteerde bestand wordt afgespeeld.

OPMERKING
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de extra functies gebruiken
Uw MP3-speler beschikt over diverse extra funcites, zoals de 
mogelijkheid tot het lezen van tekst, het instellen van het alarm en het 
bekijken van de agenda of wereldklok.
TEKST LEZEN
Of het nou gaat om een roman, het manuscript van een 
nieuw verhaal of uw scriptie; u kunt het lezen op uw MP3-
speler... met uw favoriete muziek op de achtergrond!

Voordat u begint! - De oortelefoon aansluiten, de speler 
aanzetten en de batterij controleren.
Breng tekstbestanden over naar de speler met <Media 
Studio>. Zie pagina 37. 
Stel een voorkeurstaal voor tekst in via <Settings>
(Instellingen) <Language>(Taal)  <Contents>(Inhoud). 
Zie pagina 29
Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu 
weer te geven.

1. Tik op het pictogram  in het hoofdmenu.
De <Prime Pack>(Hoofdpakket)-lijst wordt weergegeven.

2. Selecteer <Texts> (Teksten) en tik erop.
De lijst met tekstbestanden wordt weergegeven.

3. Selecteer een tekstbestand en tik erop.
De tekst wordt op het scherm weergegeven.
Houd uw vinger enige tijd op het aanraakscherm voor weergave
in volledig scherm. Om terug te gaan naar het oorspronkelijke 
scherm, houdt u het aanraakscherm opnieuw even ingedrukt.

U kunt ook een tekstbestand zoeken met behulp van de <File 
Browser> (Bestandsbrowser).
Uw MP3-speler ondersteunt de bestandsindeling TXT in de 
tekstmodus.
Ook als u een tekstbestand selecteert, kunt u naar muziek blijven luisteren.

OPMERKING
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HET TEKSTMENU GEBRUIKEN
Naar de vorige/volgende pagina gaan

Instructie 1
Tik op het pictogram [ , ] onder aan het 
aanraakscherm.

Instructie 2
Beweeg uw vinger op het scherm naar links of 
rechts.

Als u uw vinger naar links beweegt, wordt de volgende 
pagina weergegeven. Als u uw vinger naar rechts 
beweegt, wordt de volgende pagina weergegeven.

Een bladwijzer instellen
Stel een bladwijzer in om een volgende keer terug te 
gaan naar een bepaald punt in de tekst.
1. Tik op het pictogram [ ] op de gewenste 

pagina in het tekstweergavescherm.
Het menu <Bookmark>(Bladwijzer) wordt 
weergegeven.

2. Tik op <Add Bookmark> (Bladwijzer toev.).
In het huidige tekstscherm wordt een bladwijzer 
ingesteld en het symbool [ ] wordt linksboven in het 
scherm weergegeven.

Het venster Overschrijven verschijnt als er al 
eerder een bladwijzer is ingesteld. Als u <Yes>(Ja)
selecteert, wordt de eerder ingestelde bladwijzer 
verwijderd en wordt er een nieuwe bladwijzer toegevoegd.
U kunt één bladwijzer per tekstbestand instellen met een maximum van 
100 bladwijzers.

Texts 1 7.0%

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

A few will bring play their instruments 

The others dance and sing.

They pair off with their partners

as their tails begin to wag.

Add Bookmark
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Texts 1 7.0%

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

A few will bring play their instruments 

The others dance and sing.

They pair off with their partners

as their tails begin to wag.Add Bookmark

Go to Bookmark

Delete Bookmark

HET TEKSTMENU GEBRUIKEN (Vervolg)
Naar de bladwijzer gaan/de bladwijzer verwijderen
1. Tik op het pictogram [ ] in het scherm voor 

tekstweergave.
Het menu <Bookmark>(Bladwijzer) wordt weergegeven.

2. Tik op <Go to Bookmark>(Ga naar bladwijzer) 
of <Delete Bookmark>(Bladwijzer verw.).

Als u <Go to Bookmark> (Ga naar bladwijzer) 
selecteert, gaat u naar de geselecteerde bladwijzer. 
Met <Delete Bookmark> (Bladwijzer verw.) verwijdert 
u de geselecteerde bladwijzer uit het tekstbestand.

De kleur van de tekstviewer instellen
Kies in welke kleur u de tekst wilt weergeven.
1. Tik op het pictogram [ ] in het scherm voor 

tekstweergave.
Het menu <Text>(Tekst) wordt weergegeven.

2. Tik op <Text Viewer Color> (Kleur tekstviewer).
Het menuvenster <Text Viewer Color>(Kleur 
tekstviewer) wordt weergegeven.

3. Tik op het pictogram [  ,  ] om een kleur 
voor de tekstviewer te selecteren.

U kunt kiezen uit <Type 1> (Type 1) tot en met 
<Type 9> (Type 9).

4. Tik op <OK>.
De geselecteerde kleur voor de tekstviewer wordt weergegeven.

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

Text Viewer Color

Type 1

OK Cancel
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HET TEKSTMENU GEBRUIKEN (Vervolg)

De lettergrootte wijzigen
U kunt de lettergrootte van de tekst wijzigen.
1. Tik op het pictogram [ ] in het scherm voor 

tekstweergave.
Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op <Font Size> (Lettergr.).
Het menu <Font Size> (Lettergr.) wordt weergegeven.

3. Tik op het pictogram [  ,  ] om de gewenste 
lettergrootte te selecteren.

U kunt kiezen ui <Small> (Klein), <Medium> (Medium) 
en <Large>(Groot).

4. Tik op <OK>.
De lettergrootte is gewijzigd.

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

Font Size
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OK Cancel
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HET ALARM INSTELLEN
Deze speler heeft een alarm dat  u zo kunt instellen, dat deze afgaat op een 
gepland tijdstip.

Voordat u begint! - Eerst moet u de klok op de huidige tijd instellen. Zie pagina 31

1. Tik op het pictogram  in het hoofdmenu.
Het menu <Prime Pack> (Hoofdpakket) wordt weergegeven.

2. Selecteer <Alarm> (Alarm) en tik erop.
3. Tik op <New Alarm> (Nieuw alarm).

Het venster voor de alarminstellingen wordt weergegeven.

4. Tik meerdere keren op het eerste item om de frequentie 
van het alarm te selecteren.

U kunt kiezen uit <Once> (Eenmalig), <Everyday>(Elke 
dag), <Mon~Fri>(Maan-Vrijd), <Mon~Sat>(Maan-Zat), 
<Sat~Sun>(Zat-Zon) en <Off>(Uit).

5. Tik op het tweede item
Het scherm voor instelling van de alarmtijd wordt 
weergegeven.

6. Tik op het pictogram [  ,  ] om de uren, minuten en 
AM/PM in te stellen.

7. Tik op <OK> op het scherm voor instelling van de 
alarmtijd.

OK Cancel

Prime Pack

Texts

Alarm
Calendar

World Clock
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HET ALARM INSTELLEN (Vervolg)

8. Tik meerdere keren op het derde item om het 
alarmgeluid te selecteren.

U kunt kiezen uit <Alarm Sound 1>(Alarmgeluid 1) tot en met 
<Alarm Sound 3>(Alarmgeluid 3) of muziekbestanden die zijn 
toegevoegd als alarmgeluid. Zie pagina 62

9. Tik meerdere keren op het vierde item om het 
alarminterval in te stellen.

Als het interval is ingesteld, wordt het alarm herhaald volgens 
het ingestelde interval. U kunt kiezen uit <Interval: 3min> 
(interval : 3min), <Interval: 5min> (interval : 5min) en <Interval: 
10min> (interval : 10min).

10. Tik op <OK>.
Het bevestigingsvenster voor opslaan wordt weergegeven.

11. Tik op <Yes> (Ja).
De alarminstelling wordt toegevoegd aan de alarmlijst.

U kunt maximaal 7 alarmen instellen.
OPMERKING

Once

12 : 40 AM

Alarm Sound 1

Interval : 5min

Alarm
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HET ALARM INSTELLEN (Vervolg)
De alarminstelling bewerken
1. Selecteer in het alarmscherm een alarminstelling 

die u wilt wijzigen, en tik erop.
Het venster voor de alarminstellingen wordt 
weergegeven.

2. Volg dezelfde stappen als de nieuwe 
alarminstellingen hierboven om de instelling te 
wijzigen. Zie pagina 82

Een alarminstelling verwijderen
1. Tik in het alarmscherm op een te verwijderen 

alarminstelling.
2. Klik op het pictogram [ ].

Tik op het pictogram [ ] om alle alarminstellingen te 
verwijderen.
Het venster Wissen wordt weergegeven.

3. Klik op <Yes> (Ja).
Het geselecteerde alarm wordt verwijderd.

Het alarm gaat op de ingestelde tijd af. Het alarm stopt en begint opnieuw na het door u 
ingestelde interval, als het apparaat niet wordt bediend via het aanraakscherm of knoppen. 
Ingeval het apparaat niet wordt bediend, wordt het alarm gedurende een uur herhaald.
De alarmfunctie werkt niet als de USB-kabel op de speler is aangesloten.

OPMERKING

LET OP

Once

12 : 40 AM

Alarm Sound 1

Interval : 5min

Alarm

Alarm

New Alarm

AM 01 : 53
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DE AGENDA BEKIJKEN
U kunt de agenda bekijken.

Voordat u begint! - Eerst moet u de klok op de huidige tijd instellen. Zie pagina 31

1. Tik op het pictogram  in het hoofdmenu.
Het menu <Prime Pack>(Hoofdpakket) wordt weergegeven.

2. Selecteer <Calendar> (Agenda) en tik erop.
Het menu <Calendar> (Agenda) wordt weergegeven.

3. Tik op het pictogram [ , ] om de gewenste maand te 
selecteren.

Het type agenda instellen
U kunt de agenda op twee manieren weergeven.
1. Tik op het pictogram [ ] in het scherm voor 

agendaweergave.
Het menu <Calendar>(Agenda) wordt weergegeven.

2. Tik op <View Type> (Weergavetype).
Het scherm <View Type>(Weergavetype) wordt 
weergegeven.

3. Tik op het pictogram [ ,  ] om de gewenste 
weergavemodus te selecteren en tik op <OK>.

U kunt kiezen uit <Type 1> (Type 1) of <Type 2> (Type 2).
Bij <Type 1> wordt zondag tot en met zaterdag 
weergegeven, bij <Type 2> maandag tot en met 
zondag.

SUN MON TUE WEO THU    FRI SATAA

View Type

Type 1

OK Cancel

Prime Pack

Texts

Alarm

Calendar
World Clock
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DE WERELDKLOK WEERGEVEN
U kunt de locatie en datum/tijd van grote wereldsteden bekijken op basis van de 
respectievelijke tijdzone.

Voordat u begint! - Eerst moet u de klok op de huidige tijd instellen. 90 31
Stel de gewenste tijdzone in via <Settings>(Instellingen) <Time>(Tijd) <Time 
Zone>(Tijdszone).

1. Tik op het pictogram  in het hoofdmenu.
Het menu <Prime Pack>(Hoofdpakket) wordt weergegeven.

2. Selecteer <World Clock> (Wereldklok) en tik erop.
Het scherm <World Clock>(Wereldklok) wordt weergegeven.

3. Tik op het pictogram [ , ] om een tijdzone te 
selecteren.

U kunt de datum/tijd van de door u geselecteerde stad 
weergeven.

U kunt de lokale tijd van de volgende tijdzones bekijken. 
(‘/’ geeft de standaard tijdzone in de regio weer)
Cape Verde / London, Lisbon / Rome, Paris / Athens, Helsinki / Moscow, Riyadh / 
Abu Dhabi, Muskat / Tashkent, Ashgabat / Alma Ata, Kathmandu / Bangkok, Jakarta / 
Hong Kong, Beijing / Seoul, Tokyo / Guam, Sydney / Okhotsk / Wellingtons, Oakland / 
Samoa, Midway / Honolulu, Hawaii / Alyeska / Los Angeles, Seattle / 
Denver, Phoenix / Chicago, Mexico City / New York, Miami, / Caracas, Santiago / 
Buenos Aires, Brasilia / The middle Atlantic 

Prime Pack

Texts

Alarm

Calendar

World Clock
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Bluetooth gebruiken
Druk op het pictogram [ ] om naar het vorige scherm te gaan.
Houd het pictogram [ ] enige tijd ingedrukt om het hoofdmenu weer te geven.

WAT IS BLUETOOTH?
Bluetooth is een industriestandaard voor draadloze PAN’s (personal area networks). 
Bluetooth biedt verbinding en uitwisseling tussen apparaten als mobiele telefoons, 
laptops, pc’s, printers, digitale camera’s en videospelcomputers via een beveiligde, 
wereldwijd ongelicentieerde korte golf radiofrequenties.

Afhankelijk van de gebruiksomstandigheden kunnen Bluetooth-apparaten ruis of 
storingen veroorzaken.

Fysieke signaalstoringen, zoals wanneer u de speler in de hand houdt en een 
stereokoptelefoon draagt.
Wanneer een deel van het lichaam in contact is met het ontvangstsysteem van de speler of 
de stereokoptelefoon.
Spanningsvariatie als gevolg van elektrische storing door muren, hoeken of 
scheidingswanden.
Elektrische interferentie door apparatuur die dezelfde frequentie gebruikt, bijvoorbeeld 
medische apparatuur, magnetrons en draadloze LAN’s.

Houd de afstand tussen het Bluetooth-apparaat en de speler zo klein mogelijk.
Hoe groter de afstand tussen de speler en de stereokoptelefoon, des te slechter de 
kwaliteit. Als de afstand de limiet overschrijdt, wordt de verbinding verbroken.
We raden af om de tekst- en afbeeldingsmodi te gebruiken terwijl u naar muziek 
luistert via de stereokoptelefoon. Dit verslechtert zowel de prestaties van de speler 
als de Bluetooth-communicatie.
Bestanden met minder dan 32 kHz kunnen niet worden afgespeeld, afhankelijk van 
het model stereokoptelefoon.
In gebieden met een slechte ontvangst, bijvoorbeeld in een lift of ondergronds, 
werkt de Bluetooth-verbinding mogelijk niet goed.
De maximumafstand voor draadloze verbinding tussen de speler en een Bluetooth-
apparaat is 10 meter. Als de afstand groter wordt, wordt de verbinding automatisch 
verbroken. Zelfs binnen dit bereik kan de geluidskwaliteit verslechteren door 
obstakels zoals muren of deuren.

OPMERKING
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EEN BLUETOOTH-STEREOKOPTELEFOON GEBRUIKEN
U kunt een Bluetooth-stereokoptelefoon gebruiken om draadloos van muziek te 
genieten met stereogeluid van een hoge kwaliteit.

Voordat u begint! - Zorg ervoor dat het Bluetooth-apparaat dat u wilt 
aansluiten klaar is om te worden gekoppeld. (raadpleeg de 
gebruikshandleiding van het apparaat)

De Bluetooth-stereokoptelefoon registreren
(U hoeft dit product slechts één keer te registreren)

1. Tik op het pictogram  in het hoofdmenu.
Het venster voor het instellen van Bluetooth wordt 

weergegeven.

2. Tik op <Yes> (Ja).
De <Bluetooth Mode> (Bluetooth Mode) is ingesteld 
op <On>(Aan).
Het pictogram  licht op.

3. Maak de stereo-koptelefoon gereed voor 
koppeling.

Raadpleeg de producthandleiding om de koptelefoon 
gereed te maken voor de koppeling.

4. Tik op <Stereo Headset> (Stereo Koptelefoon).

5. Klik op het pictogram [ ].
Deze speler zoekt automatisch naar Bluetooth-
apparaten, ook als er niet op het pictogram [ ] is 
gedrukt.
De te registreren koptelefoon wordt in de lijst 
opgenomen.

Bluetooth

Stereo Headset
Bluetooth Mode

Bluetooth Settings
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EEN BLUETOOTH-STEREOKOPTELEFOON 
GEBRUIKEN (Vervolg)

De Bluetooth-stereokoptelefoon registreren (vervolg)
6. Tik op de naam van de koptelefoon die u wilt registreren.

Het venster voor het invoeren van het wachtwoord wordt weergegeven als 
het wachtwoord voor de koptelefoon anders is dan 0000. Raadpleeg de 
handleiding van de koptelefoon voor het wachtwoord.
De registratie van de koptelefoon is voltooid.

U kunt de Bluetooth-functie alleen gebruiken voor het afspelen van muziek- 
en videobestanden. Er is geen ondersteuning voor het luisteren naar 
FM-radio.

Beschrijving van het Bluetooth-pictogram
 : Bluetooth-modus aan  : Verbonden met een stereo-koptelefoon

U kunt de Bluetooth-functie uitschakelen via <Bluetooth> (Bluetooth) 
<Bluetooth Mode> (Bluetooth Mode)  <Off>(Uit).

Gebruik alleen stereo-koptelefoons die zijn gecertifi ceerd voor Bluetooth. 
Handsfree mono-koptelefoons worden niet ondersteund.

Schakel de <Bluetooth Mode> (Bluetooth Mode) naar <OFF> (UIT) als 
deze niet in gebruik is. Als u de <Bluetooth Mode> (Bluetooth Mode) in de 
stand <ON> (AAN) laat staan, loopt de batterij sneller leeg.

U kunt maximaal 20 apparaten toevoegen voor de Bluetooth-verbinding.

Sommige Bluetooth-stereokoptelefoons kunnen slecht communiceren met 
uw speler, afhankelijk van het model.

OPMERKING
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EEN BLUETOOTH-STEREOKOPTELEFOON 
GEBRUIKEN (Vervolg)

Verbinding maken met de geregistreerde Bluetooth-
stereokoptelefoon

1. Tik op het pictogram  in het hoofdmenu.

2. Tik op <Stereo Headset> (Stereo Koptelefoon).

3. Tik op de stereokoptelefoon om verbinding te 
maken.

Wanneer de verbinding tot stand is gebracht, ziet u het 
pictogram [ ] op het scherm.

U kunt verbinding maken met maximaal twee 
koptelefoons.

4. Speel het gewenste bestand af.
U kunt met een stereo-koptelefoon naar muziek 
luisteren.

Als u de gewenste koptelefoon niet kunt vinden, moet u deze eerst 
registreren. Zie pagina 88

De Bluetooth-verbinding wordt verbroken als u de speler of de koptelefoon 
uitschakelt en na een seconde weer inschakelt. Herhaal de bovenstaande 
instructies als u met de stereo-koptelefoon naar muziek wilt luisteren.

Als er verbinding is met twee koptelefoons, kan alleen de koptelefoon 
waarmee het eerst verbinding is gemaakt, worden ingeschakeld voor 
functionele bediening zoals afspelen/stoppen en volumeregeling. 
Raadpleeg de handleiding van de koptelefoon voor meer informatie.

OPMERKING

Stereo Headset

SBH100
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HET BLUETOOTH-MENU GEBRUIKEN

De verbinding met het Bluetooth-apparaat verbreken

1. Tik op het pictogram  in het hoofdmenu.

2. Klik op het pictogram [ ].
Het menu <Bluetooth> wordt weergegeven.

3. Tik op <Disconnect> (Afsluiten).
Het bevestigingsvenster voor het verbreken van de 
verbinding wordt weergegeven.

4. Tik op <Yes> (Ja).
Het aangesloten apparaat wordt losgekoppeld.

Het verbonden Bluetooth-apparaat controleren

1. Tik op het pictogram  in het hoofdmenu.

2. Klik op het pictogram [ ].
Het menu <Bluetooth> wordt weergegeven.

3. Klik op <Connected Device> (Verbonden 
apparaat).

Er wordt een lijst van aangesloten apparaten 
weergegeven.

Bluetooth

Stereo Headset
Bluetooth Mode

Bluetooth Settings

Disconnect

Connected Device

Bluetooth

Stereo Headset
Bluetooth Mode

Bluetooth Settings

Disconnect

Connected Device
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BLUETOOTH-INSTELLINGEN
Voordat u begint! - Stel de <Bluetooth Mode> in op <On> (Aan).

1. Tik op het pictogram  in het hoofdmenu.
2. Selecteer <Bluetooth Settings> (Bluetooth Instellingen) 

en tik erop.
Het menu <Bluetooth Settings>(Bluetooth Instellingen) wordt 
weergegeven.

3. Stel uw voorkeuren in en tik op <OK>.

Opties voor Bluetooth-instellingen
Search Timeout (Zoek Timeout) : U kunt selecteren hoe lang er naar een 
nieuw apparaat wordt gezocht. Na het instellen van een tijd, wordt er naar een 
nieuw apparaat gezocht gedurende de tijd die u hebt ingesteld. U kunt kiezen uit 
<10sec>, <20sec>, <30sec>, <45sec> en <60sec>.
Delete Device (Apparaat verwijderen) : U kunt de registratie van een apparaat 
uit de speler verwijderen. Tik op het pictogram [ ] om alle geregistreerde 
apparaten te verwijderen. Zie pagina 93
My Device Info. (Mijn Apparaat Informatie) : U kunt de naam en het adres van 
uw speler nagaan.

Bluetooth

Stereo Headset

Bluetooth Mode

Bluetooth Settings
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BLUETOOTH-INSTELLINGEN (Vervolg)
Een Bluetooth-apparaat verwijderen
1. Selecteer <Delete Device>(Apparaat

Verwijderen) en tik erop.
De lijst van geregistreerde apparaten wordt 
weergegeven.

2. Selecteer een te verwijderen apparaat en tik op 
het pictogram [ ].

Tik op het pictogram [ ] om alle geregistreerde 
apparaten te verwijderen.

3. Tik op <Yes> (Ja).
Het geselecteerde apparaat wordt verwijderd.

Een Bluetooth-apparaat hernoemen
1. Selecteer <My Device Info.> (Mijn Apparaat 

Informatie) en tik erop.
Het scherm Mijn Apparaat Informatie wordt weergegeven.

2. Klik op het pictogram [ ].
Het venster Edit Device Name (Wijzig Apparaatnaam) 
wordt weergegeven.

3. Hernoem het apparaat door op het nummer- of 
teken pictogram te tikken.

[1Aa] : De invoermodus schakelt over van cijfers naar 
Engels met hoofdletters en Engels met kleine letters.

[ ] : U kunt de tekens één voor één wissen.
[ – ] : U kunt een spatie tussen tekens plaatsen.
[OK] : Hiermee bevestigt u de wijziging.
Als u bijvoorbeeld ‘YPS5’ wilt invoeren:
-Ga naar het overeenkomstige toetspictogram en tik erop.

(één keer) (drie keer) (één keer) (drie keer) 
(twee keer) (één keer)

1Aa

My Device Info.

Edit Device Name

Bluetooth Settings

Search Timeout

Delete Device
My Device lnfo.
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problemen oplossen
Als u problemen ondervindt met uw nieuwe MP3-speler, vindt u mogelijk een 
oplossing in deze lijst. Als het probleem zich blijft voordoen, kunt u contact 
opnemen met het dichtstbijzijnde Samsung Customer Service Center.

PROBLEM OPLOSSING

Kan de speler niet 
inschakelen.

• De speler kan niet worden ingeschakeld als de 
batterij helemaal leeg is. Laad de batterij op en 
schakel de speler nogmaals in.

• Druk met een scherp voorwerp de resetopening in.

De toetsen werken niet.

• Controleer of de schakelaar  in de richting 
van de pijl is geduwd.

• Controleer of u op de juiste knop of het juiste 
pictogram drukt.

• Druk met een scherp voorwerp de resetopening in.

Het scherm wordt niet 
ingeschakeld.

• Het scherm is in vol zonlicht mogelijk niet goed 
zichtbaar.

• Als <Display Off>(Display Uit) is geselecteerd in 
<Settings>(Instellingen) <Display>(Weergave), 
wordt het aanraakscherm uitgeschakeld. 
Tik op een willekeurige knop of op het scherm en 
wacht of het scherm aangaat.

De speler wordt 
uitgeschakeld.

• Controleer de batterijstatus.
• De speler wordt automatisch uitgeschakeld wanneer 

de batterij helemaal leeg is. Laad de batterij op.
• Als u <Auto Power Off>(Autom. Uitschakelen) 

selecteert via <Settings>(Instellingen)
<System>(Systeem), zal de speler in de pauzestand 
worden uitgeschakeld. Schakel de speler in.
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PROBLEM OPLOSSING

De levensduur van 
de batterij verschilt 
met de levensduur die 
is aangegeven in de 
gebruiksaanwijzing.

• Hoelang de batterij meegaat kan variëren, 
afhankelijk van de geluids- en scherminstellingen.

• Wanneer de speler langdurig wordt blootgesteld 
aan lage of hoge temperaturen, kan dit ten koste 
gaan van de levensduur van de batterij.

Storingen in de werking 
van Media Studio

• Controleer of uw computer voldoet aan de minimum 
systeemvereisten.

Kan geen verbinding 
met de computer 
maken.

• Controleer of de USB-kabel juist is aangesloten en 
probeer het nogmaals.

• Klik op <Start> op het bureaublad van de computer 
om Windows Update uit te voeren. Selecteer 
Essentiële updates en Service packs en installeer 
alle updates. Start de computer opnieuw op en sluit 
de speler opnieuw aan.

De overdrachtssnelheid 
van bestanden is te 
laag.

• De overdrachtssnelheid is lager als u meerdere 
programma’s, waaronder <Media Studio>, op uw 
computer uitvoert. Sluit overbodige programma’s af 
en probeer het nog eens.

De speler speelt niet af • Controleer of het beschikbare bestand is 
opgeslagen in het geheugen.

• Controleer of het muziekbestand is beschadigd.
• Controleer of de batterij voldoende is opgeladen.
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PROBLEM OPLOSSING
Het uploaden van 
bestanden werkt niet.

• Controleer of de USB-kabel goed is aangesloten. 
Sluit deze zonodig opnieuw aan.

• Controleer of het geheugen vol is.
• Druk met een scherp voorwerp de resetopening in.

Er ontbreken bestanden 
of gegevens.

• Controleer of de USB-kabel is losgeraakt tijdens 
de bestandsoverdracht. Dit kan overigens niet 
alleen leiden tot ernstige beschadiging van de 
bestanden/gegevens, maar ook van het product. Let 
goed op, want Samsung is niet aansprakelijk voor 
gegevensverlies.

Abnormale afspeeltijd 
tijdens het afspelen.

• Controleer of het bestand een VBR-indeling 
(Variable Bit Rate) heeft.

Abnormale weergave 
van bestandsnaam.

• Ga naar <Settings> (Instellingen) <Language>
(Taal(Language)) <Contents> (Inhoud) in het 
hoofdmenu om de juiste taal in te stellen.

Het product wordt 
warm.

• Er komt tijdens het opladen wat warmte vrij. Dit 
heeft geen invloed op de levensduur of functies van 
het product.

Er wordt een melding 
weergegeven tijdens het 
bekijken van een video.

• Probeer de videoclip nogmaals te downloaden met 
Media Studio.

Bluetooth-verbindingen
konden niet tot stand 
worden gebracht.

• Controleer of de stereo-koptelefoon geschikt is voor 
Bluetooth. Handsfree mono-koptelefoons worden 
niet ondersteund.

• De Bluetooth-verbinding kan worden uitgeschakeld 
als u de speler of stereokoptelefoon uit- en 
inschakelt. Probeer in dit geval opnieuw verbinding 
te maken.
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bijlage
OVERZICHT VAN MENUOPTIES
Hier vindt u een overzicht van de structuur van de menu’s en functies op uw 
nieuwe MP3-speler.

Het selectievenster Menu

Videos Music Pictures FM
Radio Datacasts Prime

Pack
File

Browser Bluetooth Settings

Texts Stereo
Headset Menu Style

Alarm Bluetooth
Mode Sound

Calendar Bluetooth
Settings Display

World Clock Language

Time

System
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PRODUCTSPECIFICATIES

Model YP-P2
Classifi catie DC 5.0V / 500mA
Vermogen 
ingebouwde batterij 830 mAh / DC 3.7V 

Bestand
Compatibiliteit

GELUID : MPEG1/2/2.5 Layer3 (8kbps-320kbps, 
8kHz-48kHz), WMA (8kbps-320kbps, 
8kHz-48kHz)

VIDEO : SVI (video: MPEG4; audio: MP3 (44.1kHz 
16bit Stereo, 128kbps); 
Resolutie: 480x272; framerate: 30fps) 
WMV9 (video: WMV9 Simple Profi le; audio: 
WMA9 (max. 860kbps); 
Resolutie: 320x240 of 480x272; framerate: 
30fps)

BEELD : JPG (alleen Baseline)
Uitgangsvermogen
oortelefoon 20mW (France 5mW/CH) (16 )

Frequentiebereik 20Hz~20KHz
Signaal/ruisverhouding 89 dB bij 20 KHz LPF (gebaseerd op 1kHz 0 dB)

Afspeelduur
Maximaal 35 uur muziek afspelen (op basis van 
MP3 128kbps, volume 20, normale geluidsmodus), 
maximaal 5 uur video afspelen

Temperatuurbereik 
voor gebruik -5~35°C (23~95°F)

Houder PMMA, roestvrij staal
Gewicht 86 g
Afmetingen (BxHxD) 52 X 100 X 9,95 mm
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FM Radio
FM-frequentie 87.5~108.0MHz Totale harmonische 

vervorming FM 0.8%

Signaal-
ruisverhouding FM 59 dB Gevoeligheid FM 5dB

Draadloos systeem
Emissietype F1D
RF-stroomvoorziening 2.4mW
Zendfrequentie 2402MHz ~ 2480MHz
Ontvangstfrequentie 2402MHz ~ 2480MHz
Aantal kanalen 79 kan.
Temperatuur -10°C~ +50°C (14 ~ 122°F)
Modulatiesysteem GFSK
Communicatiemodus Semi-duplex communicatie
Vochtigheid 95%
Spec. ondersteunde versie 2.0
Module BCM2048

De inhoud van deze gebruiksaanwijzing kan ter verbetering zonder 
voorafgaande kennisgeving worden gewijzigd.
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LICENTIE
Op dit apparaat en de gebruiksaanwijzing rusten intellectuele eigendomsrechten 
en auteursrechten van derden. Het gebruiksrecht van de gelicentieerde inhoud 
is beperkt tot niet-commercieel gebruik door eindgebruikers. Commercieel 
gebruik hiervan is niet toegestaan. Het gebruiksrecht beperkt zich tot dit 
apparaat en strekt zich niet uit tot andere niet-gelicentieerde onderdelen 
of processen die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3 en die 
in combinatie met dit product gebruikt of verkocht zijn. De licentie beperkt 
zich tot het gebruik van dit product voor het encoderen en/of decoderen van 
geluidsbestanden die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3. 
Deze licentie houdt geen overdracht van rechten in voor producteigenschappen 
of -functies die niet voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3.

GEBRUIKSRECHT
Dit merkteken op het product of het bijbehorende 
informatiemateriaal duidt erop dat het niet met ander 
huishoudelijk afval verwijderd moet worden aan het einde 
van zijn gebruiksduur. Om mogelijke schade aan het 
milieu of de menselijke gezondheid door ongecontroleerde 
afvalverwijdering te voorkomen, moet u dit product van 
andere soorten afval scheiden en op een verantwoorde 
manier recyclen, zodat het duurzame hergebruik van 
materiaalbronnen wordt bevorderd.
Huishoudelijke gebruikers moeten contact opnemen met 
de winkel waar ze dit product hebben gekocht of met de 
gemeente waar ze wonen om te vernemen waar en hoe ze 
dit product milieuvriendelijk kunnen laten recyclen.
Zakelijke gebruikers moeten contact opnemen met 
hun leverancier en de algemene voorwaarden van de 
koopovereenkomsten nalezen. Dit product moet niet 
worden gemengd met ander bedrijfsafval voor verwijdering.



Declaration of Conformity
For the following product:

YP-P2**, YP-P2J** / Digital Audio Player
(The mark “*” means the memory capacity and color of product.)

Manufactured at:
1. Samsung Electronics Huizhou Co., Ltd. 

Industrial Complex, Chenjiang Town, Huizhou City, Guangdong Province, China
2. Tianjin Samsung Electronics Company. 

300457, TSEC12, 4th Avenue, TEDA, Tianjin, China
3. Samsung Electronics Slovakia s.r.o. 

Hviezdoslavova 807, 924 27 Galanta, Slovakia
4. P.T. Samsung Electronics Indonesia Co. 

Cikarang Industrial Estate JI, Jababeka Raya Blok F 29-33 Cikarang. Bekasi 17530, Indonesia
(Factory name, address)

We hereby declare, that the product above is in compliance with the essential requirements of the 
R&TTE Directive (1995/5/EC) by application of:

EN 60065:2002
EN 55020:2002+A1:2003+A2:2005
EN 55022:1998+A1:2000+A2:2003
EN 55024:1998+A1:2001+A2:2003
EN 61000-3-2:2000
EN 61000-3-3:1995+A1:2001
EN 300 328-1 v1.7.1(2006-10)
EN 301 489-1 v1.6.1(2005-09)
EN 301 489-17 v1.2.1(2002-08)
Technical documentation kept at Samsung Electronics Co., Ltd. in Korea.

Manufacturer Representative in the EU:

Youn Doo Hyun / S. Engineer
Samsung Electronics Co., Ltd. 
416,Maetan3-Dong, Yeongtong-Gu, 
Suwon-City, Gyeonggi-Do, Korea

August 20, 2007

Yong Sang Park / johtaja
Samsung Electronics Euro QA Lab. 
Blackbushe Business Park, Saxony Way, 
Yateley, Hampshire, GU46 6GG, United 
Kingdom

August 20, 2007
(Place and date of issue) (Name and signature of authorized person)



REV.1.0

Wanneer u suggesties of vragen heeft met betrekking tot Samsung producten,
gelieve contact op te nemen met de klantenservice van Samsung

Samsung Electronics Benelux BV
0900 20 200 88 (€ 0,10/Min)

www.samsung.com/nl


